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About these instructions
1 About these instructions

These instructions have been prepared with utmost care. They contain in-
formation and notes intended to ensure long-term and reliable operation.

Should you notice any discrepancies or if you have improvement requests, 
then we would be glad to receive your feedback through Customer 
Service ( p. 123).

Consider the instructions part of the product and store them in a place 
where they are readily available. 

1.1 For whom are these instructions intended?

These instructions are intended for:

• Operators:
This group is familiar with the machine and has access to the 
instructions. Specifically, chapter Operation ( p. 15) is important 
for the operators.

• Specialists:
This group has the appropriate technical training for performing 
maintenance or repairing malfunctions. Specifically, the chapter 
Setup ( p. 103) is important for specialists. 

Service Instructions are supplied separately.

With regard to minimum qualification and other requirements to be met by 
personnel, please also follow the chapter Safety ( p. 9).

1.2 Representation conventions – symbols and characters

Various information in these instructions is represented or highlighted by the 
following characters in order to facilitate easy and quick understanding:

Proper setting

Specifies proper setting.

Disturbances

Specifies the disturbances that can occur from an incorrect setting.

Cover

Specifies which covers must be disassembled in order to access the com-
ponents to be set.
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About these instructions
Steps to be performed when operating the machine (sewing and 
equipping)

Steps to be performed for service, maintenance, and installation

Steps to be performed via the software control panel

The individual steps are numbered:

First step

Second step

The steps must always be followed in the specified order.

Lists are marked by bullet points.

Result of performing an operation

Change to the machine or on the display/control panel.

Important

Special attention must be paid to this point when performing a step.

Information

Additional information, e.g. on alternative operating options.

Order

Specifies the work to be performed before or after a setting.

References

 Reference to another section in these instructions.

Safety Important warnings for the user of the machine are specifically marked. 
Since safety is of particular importance, hazard symbols, levels of danger 
and their signal words are described separately in the chapter Safety 
( p. 9).

Location
information

If no other clear location information is used in a figure, indications of right 
or left are always from the user's point of view.

1.

2.

…

•


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About these instructions
1.3 Other documents

The machine includes components from other manufacturers. Each man-
ufacturer has performed a hazard assessment for these purchased parts 
and confirmed their design compliance with applicable European and na-
tional regulations. The proper use of the built-in components is described 
in the corresponding manufacturer's instructions.

1.4 Liability

All information and notes in these instructions have been compiled in 
accordance with the latest technology and the applicable standards and 
regulations.

Dürkopp Adler cannot be held liable for any damage resulting from:

• Breakage and damage during transport

• Failure to observe these instructions

• Improper use

• Unauthorized modifications to the machine

• Use of untrained personnel

• Use of unapproved parts

Transport

Dürkopp Adler cannot be held liable for breakage and transport damages. 
Inspect the delivery immediately upon receiving it. Report any damage 
to the last transport manager. This also applies if the packaging is not 
damaged.

Leave machines, equipment and packaging material in the condition in 
which they were found when the damage was discovered. This will ensure 
any claims against the transport company.

Report all other complaints to Dürkopp Adler immediately after receiving 
the product.
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Safety
2 Safety

This chapter contains basic information for your safety. Read the instruc-
tions carefully before setting up or operating the machine. Make sure to 
follow the information included in the safety instructions. Failure to do so 
can result in serious injury and property damage.

2.1 Basic safety instructions

The machine may only be used as described in these instructions.

These instructions must be available at the machine's location at all times.

Work on live components and equipment is prohibited. Exceptions are 
defined in the DIN VDE 0105.

For the following work, switch off the machine at the main switch or 
disconnect the power plug:

• Replacing the needle or other sewing tools

• Leaving the workstation

• Performing maintenance work and repairs

• Threading

Missing or faulty parts could impair safety and damage the machine. 
Only use original parts from the manufacturer.

Transport Use a lifting carriage or forklift to transport the machine. Raise the machine 
max. 20 mm and secure it to prevent it from slipping off.

Setup The connecting cable must have a power plug approved in the relevant 
country. The power plug may only be assembled to the power cable by 
qualified specialists.

Obligations
of the operator

Follow the country-specific safety and accident prevention regulations and 
the legal regulations concerning industrial safety and the protection of the 
environment.

All the warnings and safety signs on the machine must always be in legible 
condition. Do not remove! 
Missing or damaged warnings and safety signs must be replaced 
immediately.

Requirements
to be met by

the personnel

Only qualified specialists may:

• set up the machine

• perform maintenance work and repairs

• perform work on electrical equipment

Only authorized persons may work on the machine and must first have 
understood these instructions.
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Safety
Operation Check the machine during operating for any externally visible damage. 
Stop working if you notice any changes to the machine. Report any chang-
es to your supervisor. Do not use a damaged machine any further.

Safety
equipment

Safety equipment should not be removed or deactivated. If it is essential 
to remove or deactivate safety equipment for a repair operation, it must be 
assembled and put back into operation immediately afterward.

2.2 Signal words and symbols used in warnings

Warnings in the text are distinguished by color bars. The color scheme is 
based on the severity of the danger. Signal words indicate the severity of 
the danger.

Signal words Signal words and the hazard they describe:

Symbols The following symbols indicate the type of danger to personnel:

Signal word Meaning

DANGER (with hazard symbol)
If ignored, fatal or serious injury will result

WARNING (with hazard symbol)
If ignored, fatal or serious injury can result

CAUTION (with hazard symbol)
If ignored, moderate or minor injury can result

CAUTION (with hazard symbol)
If ignored, environmental damage can result

NOTICE (without hazard symbol)
If ignored, property damage can result

Symbol Type of danger

General

Electric shock

Puncture
10 Operating Instructions 906 - 02.0 - 11/2016



Safety
Examples Examples of the layout of warnings in the text:

 This is what a warning looks like for a hazard that will result in serious 
injury or even death if ignored.

 This is what a warning looks like for a hazard that could result in seri-
ous or even fatal injury if ignored.

 This is what a warning looks like for a hazard that could result in 
moderate or minor injury if the warning is ignored.

Crushing

Environmental damage

Symbol Type of danger

DANGER

Type and source of danger!

Consequences of non-compliance.

Measures for avoiding the danger.

WARNING

Type and source of danger!

Consequences of non-compliance.

Measures for avoiding the danger.

CAUTION

Type and source of danger!

Consequences of non-compliance.

Measures for avoiding the danger.
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Safety
 This is what a warning looks like for a hazard that could result in envi-
ronmental damage if ignored.

 This is what a warning looks like for a hazard that could result in 
property damage if ignored.

CAUTION

Type and source of danger!

Consequences of non-compliance.

Measures for avoiding the danger.

NOTICE

Type and source of danger!

Consequences of non-compliance.

Measures for avoiding the danger.
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Machine description
3 Machine description

3.1 Components of the machine

Fig. 1: Components of the machine (1) 

Fig. 2: Components of the machine (2)

(1) - Quick-stop
(2) - Reel stand
(3) - Machine head
(4) - Tabletop
(5) - Tray
(6) - Protective bar

(7) - Pedal
(8) - Stand
(9) - Sewing material surface
(10) - Start buttons
(11) - Automatic material feeder
(12) - Control operating terminal

⑫

⑪
⑩

⑧

⑦

①②

⑨

③
④

⑤
⑥

(1) - Compressed air gun
(2) - Compressed air maintenance unit

(3) - Main switch

②

①

③
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Machine description
3.2 Proper use

The machine may only be used with sewing material that satisfies the 
requirements of the specific application at hand.

The machine is intended only for use with dry sewing material. The sewing 
material must not contain any hard objects.

The needle thicknesses permissible for the machine are listed in the 
Technical data ( p. 131) chapter.

The seam must be completed with a thread that satisfies the requirements 
of the specific application at hand.

The machine is intended for industrial use.

The machine may only be set up and operated in dry conditions on well-
maintained premises. If the machine is operated on premises that are not 
dry and well-maintained, then further measures may be required which 
must be compatible with DIN EN 60204-31. 

Only authorized persons may work on the machine.

Dürkopp Adler cannot be held liable for damages resulting from improper 
use.

3.3 Declaration of Conformity

The machine complies with European regulations ensuring health, safety, 
and environmental protection as specified in the declaration of conformity 
or in the declaration of incorporation.

WARNING

Risk of injury from live, moving and cutting 
parts as well as from sharp parts!

Improper use can result in electric shock, crushing, 
cutting and punctures.

Follow all instructions provided.

NOTICE

Non-observance will lead to property damage!

Improper use can result in material damage at the machine.

Follow all instructions provided.
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Operation
4 Operation

The operating sequence consists of several different steps. Fault-free op-
eration is necessary in order to achieve a good sewing result.

4.1 Switching on and off the machine

Abb. 3: Switching on and off the machine

Switching on the machine

To switch on the machine: 

1. Turn the main switch (1) to the right into the I position.

 The machine performs a reference run.
After referencing, the startup screen is displayed on the operating ter-
minal for a few seconds.

Information

On the start screen, you can set the language for the user interface in the 
Language menu or open the Service menu ( p. 41).

(1) - Main switch

①

Operating Instructions 906 - 02.0 - 11/2016 15



Operation
Switching off the machine

To switch off the machine: 

1. Turn the main switch (1) to the left into the 0 position.

 All drives and the control are disconnected from the mains grid.

4.2 Switching on and off threading mode

Abb. 4: Switching on and off threading mode

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

The machine must be switched off in advance 
before all preparation, maintenance and cleaning 
work on the machine.

When threading mode is active, do not reach into 
the hook area until this is lit up. 

(1) - Drive carriage
(2) - Hook cover

(3) - Threading mode push button

③

②
①
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Operation
Switching on threading mode

1. Press in push button (3).

Important

The button must latch into place.

 The machine is in threading mode.
The drive carriage (1) is moved to the left position.
The lamp in the button lights up.
The area around the hook cover (2) is lit up.

Switching off threading mode

1. Press in the push button (3).

Important

The push button must latch out of place.

4.3 Switching on Quick-stop

The Quick-stop switch (1) can be used to immediately stop all working 
steps on the machine, e.g. after an operating error.

WARNING

Risk of injury from moving parts!

Crushing possible.

After a Quick-stop, power is still present in the 
machine, and the clamps can move.

You must always switch the machine off at the main 
switch before performing any maintenance or 
cleaning work.
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Operation
Stopping working steps via Quick-stop

Abb. 5: Switching on Quick-stop (1)

1. Press the Quick-stop switch (1).

 All working steps on the machine are immediately stopped.

Switching off the power to the machine

Abb. 6: Switching on Quick-stop (2)

1. Turn the main switch (2) to the left into the 0 position. 

 All drives and the control are immediately disconnected from the 
mains grid.

(1) - Quick Stop switch

①

(2) - Main switch

②
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Operation
4.4 Sewing on pre-bound pockets

After pressing both start buttons, the sewing process is carried out step-
by-step:

• The transfer plate transfers the sewing material to the clamp and 
moves back into its starting position.

• The sews the pre-bound pocket onto the sewing material.

• The automatic stacker places the sewn product onto the bundle mount.

WARNING

Risk of injury from moving parts!

Crushing possible.

During the sewing process, machine parts move 
quickly.

After pressing both start buttons, do not reach into 
the transfer plate, the drive carriage or the 
automatic stacker.

Only feed in the next sewing material once the 
transfer plate has transferred the sewing material 
and has returned to the starting position.

NOTICE

Property damage may occur!

Sewing without material may damage the machine.

Always place material under the transfer plate before starting the 
sewing process.
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Operation
Preparation

Abb. 7: Sewing on pre-bound pockets (1)

To sew on pre-bound pockets: 

1. Place a bundle of sewing material onto the sewing material support 
surface of the start buttons.

2. Place the sewing material under the transfer plate and align it with the 
marks.

3. Press the pedal.

 The transfer plate is closed.

4. Place the pre-bound pocket to fit into the shape cut-out of the transfer 
plate.

Start sewing

1. Press both start buttons.

 The sewing process starts.

Information

When the transfer plate has transferred the sewing material and has 
returned to the starting position, you can prepare the next sewing process 
(feed-in sewing material and insert pre-bound pocket).

Removing the bundle from the tray on the automatic stacker

The machine will stop when the tray on the automatic stacker is full. 
A message on the screen indicates that you should remove the bundle.

(1) - Sewing material
(2) - Transfer plate

(3) - Pre-bound pocket

①

③

②
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Operation
Abb. 8: Sewing on pre-bound pockets (2)

To remove a bundle from the tray on the automatic stacker: 

1. Remove bundle from automatic stacker

2. Confirm with OK.

 The machine is ready for the next sewing process.

4.5 Swiveling the machine head

The machine head can be swiveled up for maintenance work.

WARNING

Risk of injury from moving parts!

Crushing possible.

Switch off the machine at the main switch before 
swiveling up the machine head and performing 
maintenance.
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Operation
4.5.1 Swiveling up the machine head

Important

The drive carriage (2) must be moved to the left stop position.

Abb. 9: Swiveling up the machine head (1)

To swivel up the machine head: 

1. Press in threading mode push button (3) ( p. 16).

 The drive carriage moves to the left stop position.

2. Turn the main switch (1) to the left into the 0 position.

 All drives and the control are disconnected from the mains grid.

Abb. 10:  Swiveling up the machine head (2)

3. Release the locking lever (4) under the tabletop.

4. Lift the machine head in the head cover region (1) and swivel up 
carefully.

 The latch (5) latches into place.
The space under the stand is now accessible.

(1) - Head cover
(2) - Drive carriage

(3) - Threading mode push button

①

②
③

(4) -  Locking lever (5) - Latch

④
⑤
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Operation
4.5.2 Swiveling down the machine head

Fig. 11:  Swiveling down the machine head

To swivel down the machine head: 

1. Hold the machine head in the head cover region.

2. Release the latch (2).

3. Carefully swivel down the machine head.

4. Latch the locking lever (1) under the tabletop.

NOTICE

Property damage may occur!

The machine may be damaged by the machine head falling.

When swiveling down the machine head, hold the machine head in 
place until it has returned to its position.

(1) - Locking lever (2) - Latch

①

②
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Operation
4.6 Inserting/changing the needle

Abb. 12: Changing the needle

To change the needle: 

1. Push the hand crank (1) down and rotate it to the left until the needle 
bar (2) reaches the highest position.

2. Loosen hexagon screw (3) (screwdriver width 2 mm)

3. Pull the needle downwards out of the needle bar (2).

4. Insert the new needle into the needle bar (2) until it reaches the end 
stop.

Important

The groove (4) must face toward the hook.

5. Tighten the hexagon screw (3). 

Order

WARNING

Risk of injury from sharp parts!

Punctures possible.

Switch off the machine at the main switch before 
you change the needle.

Do not reach into the needle tip.

(1) - Hand crank
(2) - Needle bar

(3) - Hexagon screw
(4) - Groove

③
②

①

④

NOTICE

Property damage may occur!

Risk of damage to machine and thread if hook distance is incorrect.

After switching to a different needle thickness, adjust the distance 
between needle and hook.
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Operation
After switching to a different needle thickness, adjust the distance between 
hook and needle ( Service Instructions).

Disturbances if hook distance is incorrect

• After inserting a thinner needle:

• Missing stitches

• Thread damage

• After inserting a thicker needle:

• Damage to the hook tip

• Damage to the needle

4.7 Threading the needle thread

Abb. 13: Threading the needle thread (1)

To thread the needle thread: 

1. Fit the thread reel on the reel stand. 

2. Guide the needle thread through a hole in the guide on the thread guide.

WARNING

Risk of injury from sharp parts!

Punctures possible.

Switch off the machine at the main switch before 
threading the needle thread.

Do not reach into the needle tip.

(1) - Thread lever
(2) - Thread regulator
(3) - Guide
(4) - Guide
(5) - Thread tension spring
(6) - Diverter

(7) -  Guide
(8) -  Guide
(9) - Tension disks
(10) - Tension disks
(11) - Guide

①

②
③
④

⑤ ⑥
⑦
⑧
⑨
⑩

⑪
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Operation
Important

The thread guide must be parallel to the thread stand.

3. Use a compressed air gun to blow the thread through the hose guide.

Information

To blow the thread through the hose guide, position the compressed air 
gun together with the end of the thread at the upper end of the hose guide. 
Briefly squeeze the trigger once. 

4. Insert the thread through the guide (11): From the rear to the front 
through the uppermost hole, from the front to the rear through one of 
the middle holes, from the rear to the front through one of the lower 
holes.

5. Feed the thread counterclockwise around the tensioner (10).

6. Feed the thread clockwise around the tensioner (9).

7. Insert the thread through the guides (8) and (7).

8. Feed the thread clockwise around the diverter (6).

9. Feed the thread under the thread tensioning spring (5), through the 
guide(3) and through the thread regulator (2) to the thread lever (1).

10. Feed the thread through the thread lever (1) and thread guide (4).

Abb. 14: Threading the needle thread (2)

11.  Insert the thread through the needle thread monitor(12) and the thread 
clamp (13).

12.  Insert the thread through the guides (14) and (15).

13.  Insert the thread through the needle eye in such a way that the loose 
thread end faces the hook.

(12) - Needle thread monitor
(13) - Thread clamp

(14) - Guide
(15) - Guide

⑫

⑬
⑭
⑮
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Operation
4.8 Setting the thread regulator

The thread regulator determines the needle thread quantity to be guided 
around the hook. The required thread quantity depends on the thickness 
of the sewing material, the thread strength, and the stitch length.

• Larger thread quantity for

• thick sewing material

• thick thread strengths

• large stitch lengths 

• Lower thread quantity for

• thin sewing material

• thin thread strengths

• small stitch lengths

Proper setting

The loop of the needle thread slides at low tension over the thickest point 
of the hook. The largest amount of thread is required, and the thread 
tension spring (1) should be pulled approx. 0.5 mm out of the lower end 
position.

Abb. 15: Setting the thread regulator

To set the thread regulator: 

1. Undo the fastening screw (2) with a cross-head screwdriver.

2. Move the thread regulator (3):

• Lower thread quantity: Slide the thread regulator (3) to the right.

• Larger thread quantity: Slide the thread regulator (3) to the left.

3. Tighten the fastening screw (2).

(1) - Thread tension spring
(2) - Fastening screw

(3) - Thread regulator

①

②
③
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Operation
4.9 Winding the hook thread

The separate winder allows the hook thread to be wound while sewing or 
independently of sewing.

Abb. 16: Winding the hook thread

To wind the hook thread: 

1. Place the thread reel on the thread reel holder and guide the needle 
thread through the hole in the guide on the thread guide.

Important

The thread guide must be parallel to the thread stand.

2. Insert the thread in a wavelike manner through the three holes of the 
thread guide plate (2), so that the thread can be laid clockwise around 
the tensioner (1).

3. Feed the thread clockwise around the tensioner (3).

4. Insert the thread in a wavelike manner through the two rear holes of 
the thread guide plate (3): From bottom to top through the rear hole 
and from top to bottom through the front hole.

5. Plug an empty bobbin on the winding shaft (4) and turn clockwise until 
it clicks into place.

6. Feed the thread to the winder, clamp the thread behind the cutter and 
tear the thread off.

(1) - Winding tensioner
(2) - Thread guide plate
(3) - Thread guide plate

(4) - Bobbin shaft
(5) - Bobbin winder flap
(6) - Cutter

⑥

② ①③④⑤
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7. Press the bobbin winder flap (4) against the bobbin.

 The winder starts and stops automatically when the configured 
bobbin filling volume is reached. 
The setting of the bobbin filling quantity is described in the 
 Service Instructions.

4.10 Changing the bobbin

Abb. 17: Changing the bobbin (1)

To change the bobbin: 

1. Press the threading mode (1) push button.

 The drive carriage moves to the bobbin change position.
The cover plate (2) swivels to the side.
The sewing feet are moved to the lower position.
The lighting is switched on.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch the machine to threading mode before 
changing the bobbin.

(1) - Threading mode push button (2) - Cover plate

①

②
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Abb. 18: Changing the bobbin (2)

2. Swivel up the bobbin case retainer (4).

3. Remove the empty bobbin.

4. Insert a full bobbin (3).

Important

Insert the bobbin (3) so that it moves in the opposite direction of the hook 
when the thread is pulled out.

5. Feed the hook thread through the slot (7) in the bobbin case retainer.

6. Pull the hook thread under the tension spring (6).

7. Feed the hook thread through the guide (5) and pull it approx. 3 cm 
further.

8. Close the bobbin case retainer (4).

9. Release the threading mode (1) push button.

 The cover plate (2) swivels back to the original position.

10. If the bobbin has been changed by the program without being requested 

to do so (e.g. in the event of a color change), tap the  Bobbin 
change button on the main screen. 
This confirms that a new bobbin has been inserted and that the thread 
consumption must resume counting from the value corresponding to 
the full bobbin capacity. 

Information

If the bobbin has been changed because it was empty, the thread 
consumption will be counted from full bobbin capacity after a bobbin 
change. 

(3) - Bobbin
(4) - Bobbin case retainer
(5) - Guide

(6) - Tension spring
(7) - Slot

⑤

⑥

⑦

③
④
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4.11 Thread tension

Together with the hook thread tension, the needle thread tension influenc-
es the final seam pattern. With thin sewing material, excessive thread ten-
sion can lead to undesired gathering and thread breakage.

Proper setting

If the tension of needle thread and hook thread is identical, the thread 
interlacing lies in the middle of the sewing material.
Set the needle thread tension so that the desired seam pattern is achieved 
with the lowest possible tension.

Abb. 19: Thread tension

4.11.1 Setting the needle thread tension

The needle thread tension can only be set using the software of the control 
panel; for detailed information, refer to the chapter Programming ( p. 55).

(1) - Identical needle thread and hook thread tension
(2) - Hook thread tension higher than needle thread tension
(3) - Needle thread tension higher than hook thread tension

③

②

①
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4.11.2 Setting the hook thread tension

Abb. 20: Setting the hook thread tension (1)

To set the hook thread tension: 

1. Press the threading mode (1) push button.

 The drive carriage moves to the bobbin change position.
The cover plate (2) swivels to the side.
The sewing feet are moved to the lower position.
The lighting is switched on.

Abb. 21: Setting the hook thread tension (2)

The hook thread tension is generated by the tension spring (3) and adjust-
ed via the adjustment screw (4).

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Switch the machine to threading mode and then set 
the hook thread tension.

(1) - Threading mode push button (2) - Cover plate

①

②

(3) - Tension spring (4) - Adjusting screw

③

④
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Increasing tension

1. Turn the adjusting screw (4) clockwise.

Reducing tension

1. Turn the adjusting screw (4) counterclockwise.

Order

1. Release the threading mode (1) push button.

 The cover plate (2) swivels back to the original position.

4.12 Changing the configuration set

For pockets with a different shape, you must change the configuration set. 
A configuration set is comprised of an inner slider, the outer frame and the 
transfer plate.

To change the configuration set, you must activate the clamp change mode.

Abb. 22: Changing the configuration set

(1) - Inner slider
(2) - Outer frame

(3) - Transfer plate

①

②
③
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4.12.1 Activating the clamp change mode

Abb. 23: Activating the clamp change mode

To activate clamp exchange mode: 

1. Switch on the machine and move it to initial position.

2. Tap the menu items Extras > Clamp exchange mode.

 The clamp change window is displayed: The clamp change mode is 
active.

4.12.2 Changing the outer frame and inner slider

You must first disassemble the outer frame and then the inner slider. 
The installation takes place in reverse order.

Disassembling the outer frame and inner slider

Abb. 24: Disassembling the outer frame and inner slider

(1) - Button for the inner slider
(2) - Button for the outer frame

(3) - Button for the transfer plate

①

②

③

(1) - Outer frame (2) - Inner slider

①

②
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To remove the outer frame and the inner slider: 

1. Hold the outer frame (1) with your left hand.

2. Tap the 2 button on the screen.

 The locking device opens.

3. Tilt the outer frame (1) slightly and carefully pull it out towards the front 
of the bracket.

4. Hold the inner slider (2) with your left hand.

5. Tap the 1 button on the screen.

 The locking device opens.

6. Tilt the inner slider (2) slightly and carefully pull it out of the bracket to 
the front.

Assembling the inner slider

Abb. 25: Assembling the inner slider

To assemble the inner slider: 

1. Spread the inner slider (1), slide as far as the stopper (3) into the bracket 
and hold it in this position.

Important

The guide drill hole of the slider must be positioned in the pin of the driver (2). 
The inner slider must remain fully apart. 

(1) - Inner slider
(2) - Driver pin

(3) - Stopper bracket

①

②

③
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2. Tap the 1 button on the screen.

 The transfer plate is closed.

3. Check whether the inner slider lies fully at the limit stop (3). 

4. Correct if necessary. 

Assembling the outer frame

Abb. 26: Assembling the outer frame

To assemble the outer frame: 

1. Slide the outer frame (1) as far as the stopper (2) into the bracket and 
hold it in this position.

2. Tap the 2 button on the screen.

 The transfer plate is closed.

(1) - Outer frame (2) - Stopper bracket

①

②
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4.12.3 Changing the transfer plate

Disassembling the transfer plate

Abb. 27: Disassembling the transfer plate

To disassemble the transfer plate: 

1. Hold the transfer plate (1) with your left hand.

2. Tap the 3 button on the screen.

 The locking device is released.

3. Tilt the transfer plate slightly and carefully pull it out of the bracket to 
the left.

Assembling the transfer plate

Abb. 28: Assembling the transfer plate

To assemble the transfer plate: 

1. Slide the transfer plate (1) as far as the stopper (2) into the bracket 
and hold it in this position.

2. Tap the 3 button on the screen.

 The transfer plate is closed.

(1) - Transfer plate

①

(1) - Transfer plate (2) - Stopper bracket

②
①
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4.12.4 Ending clamp change mode

The clamp change mode can only be ended once all locking devices are 
closed on the configuration set.

To end clamp exchange mode: 

1. Confirm with OK.

2. Perform a contour test to ensure the configuration set is set correctly 
and the selected seam program suits the configuration set ( p. 50).

Important

The contour must be within the boundaries of the sewing field. Open an 
appropriate sequence for the configuration set ( p. 50).

NOTICE

Property damage may occur!

Damage to the machine by exceeding the sewing field size.

If the sequence or seam programs do not match the configuration 
set, the movement of the clamps during sewing can cause damage 
to the machine or the sewing material.

Ensure that only sequences and seam programs which are suitable 
for the configuration set are used.
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5 Programming

The control is operated via the operating terminal (1) at the automatic 
material feeder.

Abb. 29: Settings via software

The operating terminal contains a touch-sensitive screen (touchscreen). 
Buttons and elements are displayed on the touchscreen. A command is 
executed by touching a button or an element. 

Activating a button/selecting an element

1. Touch the corresponding button or element.

5.1 Structure of the software

You can create and manage seam programs and sequences via software. 
During sewing, these programs are called up and processed stitch by 
stitch.

The software is also used to define general settings that apply to all 
programs.

The software also includes technical menu items for testing and maintain-
ing the machine.

(1) - Operating terminal

NOTICE

Property damage may occur!

Damage can be caused to the touchscreen from sharp parts.

Only operate the touchscreen with a finger or a special stylus.

①
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Seam program

A seam program consists of a seam contour with parameters defining the 
individual contour sections.

Up to 99 seam programs can be stored in the system. Seam programs 
have a file suffix of .fnp906 after the filename.

Sequence

• A sequence is comprised of at least 2 seam programs.

• Up to 30 seam programs can be combined in any order to form a 
sequence.

• Up to 20 sequences can be stored in the system. Sequences have a file 
suffix of .seq906 after the filename.

5.2 Overview of the menu structure

The following table provides an overview of the menu structure and the 
function buttons on the main screen.

Different colors indicate which functions are mainly used for normal sew-
ing operations, which items are used for creating and maintaining seam 
programs and the menu items that are used for making technical settings.

Green: Menu items for sewing

Blue: Menu items for creating and managing programs

Magenta: Menu items for settings and information used by technicians

Menu items in popup menus

Menu item Function Subitems Subitems Described on

File Open existing sewing 
programs, create new 
programs, copy or delete 
existing programs.

Delete  p. 65

Copy  p. 63

Open  p. 50

New Seam program  p. 55

Sequence  p. 61

Save As  p. 63

Edit Define general settings 
for all programs or 
modify an existing 
program.

Machine parameters  p. 74

Sequence  p. 74

Seam program Parameter  p. 69

Contour adjustment  p. 66

Testing Contour  p. 60
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5.3 Starting the software

After switching on the machine at the main switch and pressing both start 
buttons, the machine performs a reference run. After this, the start screen 
is shown on the operating terminal for a few seconds.

Abb. 30: Starting the software (1)

Extras Change the 
configuration set

Notice: Remove bundle 
from automatic stacker

Display options:
full-screen and zoom

Technician menu: 
Adjustments, system 
information and tests

Clamp exchange 
mode

 p. 34

Bundle removal  p. 19

Full screen on / off  p. 50

Zoom on / off  p. 50

Service Adjustments  p. 78

System information  p. 81

Multi-test  p. 78

Initialization 
and update

 p. 87

Manufacturer (for DA personnel only)

Correction Short-term sewing with 
other values

Thread tension  p. 51

Sewing speed  p. 52

? Software version of the 
control unit panel

Info  p. 89

Menu items in popup menus

Menu item Function Subitems Subitems Described on

Buttons on the main screen

Button Function Subitems Described on

Continue sewing the contour from a particular point Repair mode  p. 54

Define announcement of the bobbin change. The 
thread consumption is set in meters for this.

Bobbin change  p. 53

Reset counter to a particular value Reset counter  p. 54

(1) - Language selection button (2) - Service

① ②
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Using the start screen, you can select the user interface language or use 
Service (2) to quickly switch to the Multi-test menu.

Information/Information/Informace

Both functions can also be accessed later from within the program via the 
menu items Extras > Service ( p. 82 and  p. 80). 

If you do not tap any buttons, the display automatically switches to the 
main screen after a few seconds.

The main screen

The main screen is displayed during sewing. When the machine is started, 
the start screen is opened with the settings of the last sewing program 
used.

Abb. 31: Starting the software (2)

Title bar (1)

On the main screen, the currently open sequence is displayed and the 
time of day (10) is displayed at the right. In the various menus, this bar 
contains information on the currently selected menu item.

Main window (2)

The contour to be sewn is displayed here.

(1) - Title bar
(2) - Main window Display of the seam 

contour
(3) - Program bar
(4) - Menu bar: Popup menu
(5) - Arrow buttons for navigating

within the bar

(6) - Button for resetting the counter
(7) - Button for bobbin change
(8) - Display of the current sewing

parameters
(9) - Button for Repair mode
(10) - Display of time of day

⑦

⑨

⑩

⑥
⑤④

③

②

①

⑧
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Program bar (3)

The seam programs of the sequence currently open are displayed here. 
The program currently being executed is highlighted in black. With the 
arrow keys (5) on the right, you can move additional seam programs into 
the visible bar area.

When a single seam program is opened, this fills the entire bar width.

Menu bar (4)

The menu bar contains the popup menu. The popup menu allows you to 
access the various different menu items for creating and editing seam pro-
grams and for performing settings and tests on the machine. An arrow () 
next to the entry shows that additional sub-menu items are available.

Arrow buttons (5) for navigating within the bar

With the arrow keys (5) on the right, you can move additional seam pro-
grams into the visible bar area.

Button for resetting the counter (6)

This button can be used for resetting the counter for the sewn programs 
or sequences. The current counter value is displayed in this button.

Button for bobbin change (7)

This button is used to inform the system that a new bobbin has been 
inserted (e.g. after a color change). The hook thread capacity is displayed 
in this button.

Display of the current seam parameters (8)

•  - Dimensions of the seam pattern

•  - Sewing speed

•  - Thread tension

•  - Number of stitches/hook thread consumed

Button for Repair mode (9)

This button is used to switch the Repair mode on and off. The current 
status (On / Off) is displayed in the button.
Operating Instructions 906 - 02.0 - 11/2016 43



Programming
5.4 Basic functions for using the software

5.4.1 Enter master password

The master password is requested for technical areas. It is not intended 
for the operator and cannot be changed ( p. 79).

To enter the master password: 

1. When the Password display appears, enter the master password using 
the number keys (2). 

Abb. 32: Entering the operator password

 The input appears in the data entry field (1). 

Information

You can delete incorrect entries via the DEL button.

2. Confirm with OK.

 The selected technical area opens. 

5.4.2 Closing windows

A number of different buttons can be used for closing the currently open 
window.

(1) - Input field (2) - Numeric buttons

①

②

Button Meaning

At the upper right in the title bar of all windows:
• The program jumps back by one navigation level.

OK In windows with data entry or selection fields:
• The window is closed and the entered or selected data is adopted.

ESC
Abort

In windows with data entry or selection fields:
• The window is closed and the entered or selected data is discarded.
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5.4.3 Display principles

Abb. 33: Display principles

The currently activated or selected element is highlighted with a dark 
background (2).

Buttons that are not used in the current context are grayed-out (1).

5.4.4 Scrolling the display

Abb. 34: Scrolling the display

A scrollbar (1) appears at the right side when a displayed image is larger 
than the screen height.

(1) - Grayed-out: Deactivated element (2) - Dark background: Activated element

(1) - Scrollbar

①

②

①
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Moving image up/down

1. Drag the scrollbar (1) up or down.

5.4.5 Selecting options from a list

When selecting options, a distinction is made between round option buttons 
and square checkboxes.

Selection with option buttons

Abb. 35: Selection with option buttons

With round option buttons you can only select one of the displayed options.

1. Tap the desired option.

 The selected option (1) is marked with a dot.

Selection with checkboxes

Abb. 36: Selection with checkboxes

Checkboxes allow you to select multiple entries.

1. Tap the desired checkboxes.

 The selected entries (1) are marked with a cross.

(1) - Option buttons: Selected element

①

(1) - Checkbox: Selected elements

①
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5.4.6 Using file filters

When opening, copying or deleting seam programs or sequences, a list of 
all available files is displayed.

You can use the filter functions to make the list more manageable. 

To use file filters: 

1. Tap the File Filter button under the list.

 The file filter screen opens.

Abb. 37: Using file filters

2. Tap the desired filter criterion:

• .fnp911: Seam programs only

• .seq911: Sequences only

• All Files: Seam programs and sequences

3. Tap the Open button.

 The list is updated according to the selected filter:
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5.4.7 Entering text

A text entry window is displayed when you need to enter text, e.g. for the 
name of a program.

Abb. 38: Entering text

Writing text

1. Use the keyboard (2) to enter the text.

Switching between uppercase/lowercase

1. Tap the Aa (5) button.

Deleting the last character

1. Tap the DEL (4) button.

Adopting the entered text

1. Confirm with OK (3).

 The entered text is adopted, and the text entry window is closed.

(1) - Input field
(2) - Keyboard
(3) - OK: Adopt the entered text

(4) - Del: Delete a character
(5) - Aa: Switching between uppercase/

lowercase

③
④
⑤

①

②
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5.4.8 Entering parameter values

A numeric entry window opens when you need to enter numeric values for 
program or machine parameters.

Abb. 39: Entering parameter values

The title bar (1) shows the parameter group.

The status bar (2) shows the name of the parameter currently being edit-
ed. The symbol (3) of the parameter is displayed below.

The value range (4) shows the entry limits for the parameter.

The current valid value is displayed in the input field (5). You can change 
this value.

Entering a value

Positive value:

1. Enter required values using the displayed keyboard (6).

Negative value:

1. First enter the first number, then the sign and any additional numbers 
using the numeric buttons (6).

• Example -12: Enter the value in the order 1, -, 2.

Deleting a value

1. Tap the DEL button.

Adopting a value

1. Confirm with OK.

 The entered value is adopted, and the numeric entry window is closed.

(1) - Title bar
(2) - Status bar
(3) - Symbol

(4) - Value range
(5) - Input field
(6) - Numeric buttons

③
④
⑤

⑥

①

②
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5.4.9 Switching on and off the full-screen display 

In order to see the seam contour in more detail you can switch the main 
screen to occupy the full screen and hide the buttons at the right side of 
the main screen.

Abb. 40: Switching the full-screen display on and off

1. Tap the menu items Extras > Full-screen on / off.

 The display switches to the respective other mode.

5.4.10 Switching on and off zoom 

You can magnify the display in a zoom level in order to see the seam 
contour in more detail.

Switching between the displays

1. Tap the menu items Extras > Zoom on / off.

 The display switches to the respective other mode.

5.5 Opening a seam program or sequence for sewing

The stored seam programs or sequences frequently need to be opened 
for sewing.

To open a seam program or sewing sequence for sewing: 

1. Tap the menu items File > Open in the main window.

 The selection window appears. All seam programs and sequences 
are displayed.

Information

Using File filter, you can limit the selection and make the list more 
manageable ( p. 47).

(1) - Full-screen switched off (2) - Full-screen switched on

①

②
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Abb. 41: Opening a seam program or sequence for sewing

2. Tap the desired file.

3. Tap the Open button.

 The seam program/sequence is opened.

4. Press both start buttons to start sewing.

5.6 Briefly sewing with modified values

If you briefly need to sew a special material or use a particular thread 
strength with different values, without changing the seam program, you 
can use the Correction menu item to temporarily change the values for 
thread tension and speed. The values then apply to all subsequently exe-
cuted seams. The values are deleted when the machine is switched off.

Important

If you wish to adopt the changes permanently, you must modify and 
save the program. Otherwise, the last save values after switching off the 
machine are restored.

5.6.1 Sewing with a modified thread tension

To sew with a modified thread tension: 

1. Tap the menu items Correction > Thread tension.

 The window for changing the thread tension appears:
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Abb. 42: Sewing with a modified thread tension

2. Enter the desired value for the thread tension.

3. Confirm with OK.

 The value is adopted and used for all seams until the machine is 
switched off.

5.6.2 Sewing with a modified speed

To sew with a modified speed: 

1. Tap the menu items Correction > Sewing speed.

 The window for changing the thread tension appears:

Abb. 43: Sewing with a modified speed

2. Enter the desired speed.

3. Confirm with OK.

 The value is adopted and used for all seams until the machine is 
switched off.
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5.7 Fixing a thread breakage

The machine automatically detects when the needle thread has been 
used up or broken and a new bobbin needs to be inserted.

The Fix thread breakage window then opens automatically.

Abb. 44: Fixing a thread breakage

To fix a thread breakage: 

1. To check whether the needle thread is broken, tap the Bobbin change 
button.

2. Changing the bobbin ( p. 29).

 A window counting the thread consumption from full bobbin capacity 
is displayed. 

3. Press Yes to confirm that the thread consumption of the new bobbin 
should be counted from full bobbin capacity. 

4. Tap the Continue sewing button. 

5. Use the Forwards and Back buttons to move to the point where sewing 
is to continue.

 The program jumps back to the main screen and sewing of the seam 
continues from the selected point.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

 Switch the machine to threading mode before 
changing the bobbin.
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5.8 Continuing a seam in Repair mode after an error

If an error occurs, e.g. a thread breakage, the seam must be continued in 
Repair mode. 

In Repair mode, you can move to any desired point on the contour. E.g. in 
order to continue the seam program from this position after an error has 
occurred or repeat a few stitches.

To continue a seam in Repair mode after an error: 

1. Tap the  Repair mode button on the main screen.

 The Repair mode window is displayed.

Abb. 45: Continuing a seam in Repair mode after an error

2. Use the Forwards and Back buttons to move to the point where sewing 
is to continue.

3. Tap the Continue sewing button.

 The program switches to the main screen. The seam continues to be 
sewn from this point.

5.9 Resetting the counter

Depending on the machine parameter settings, the counter counts the sewn 
programs or sequences up or down. You can use the Reset Counter button 
to reset the counter to the start value ( p. 78).

1. Tap the  Reset Counter button on the main screen.

 The counter is reset to the value defined in the machine parameters.
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5.10 Creating a new seam program

A new seam program is created using a teach-in procedure. 
Individual seam paths with specific seam parameters are defined via the 
operating terminal in order to do this.

To create a new seam program: 

1. Tap the menu items File > New > Seam Program.

 The teach-in window is displayed. 

Abb. 46: Creating a new seam program (1)

Defining the starting point

2. Use the arrow buttons (2) to move the cursor (3) to the desired starting 
position.

3. Confirm with OK.

 The desired starting point is adopted and marked with a green dot.

NOTICE

Property damage may occur!

Sewing without material may damage the machine.

Always place material under the transfer plate before starting the 
sewing process.

(1) - Cursor
(2) - Arrow buttons
(3) - OK button: Adopt
(4) - Save button

(5) - Delete button
(6) - Parameter button
(7) - Line selection button

①
⑦
⑥

⑤
②

③

④
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Selecting the line type

4. Use the line selection buttons (7) to select the type of line to be defined.

•  Seamless path
The clamp moves over this path to the next position without sewing.

•  Straight seam
A straight seam is sewn.

•  Curved seam
A curved seam is sewn.

 After tapping the button for a straight or curved seam the correspond-
ing window for entering the seam parameters for this path opens.

Defining the seam parameters for the path

Abb. 47:  Creating a new seam program (2)

Selecting the seam parameters for the path

5. Tap the respective parameter.

 The window for entry opens.

6. Enter the desired value for the parameter ( p. 49).
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Seam parameters for teach-in

Drawing a path

7. Use the arrow buttons to move the cursor to the end point of the desired 
path.

Information

Alternatively, you can tap an arrow button once in order to define the 
direction and then continue moving in this direction by pressing the pedal.

Important

Take care to ensure that the contour remains within the permissible 
sewing field of your particular machine. Especially with curved paths, you 
should remember that the start and end points are not directly connected 
and that a curve is generated between these two points.

8. Confirm with OK.

 The seam path is adopted with the specified parameters.

Adding further seam paths

Further seam paths are defined using the same procedure.

9. Add each new seam path by starting at step 4 ( p. 56).

Button Meaning

Speed

Stitch length

Thread tension

Stroke height

Thread cutting
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Deleting a seam path

10. Tap the Delete button.

 The last section of the seam path is deleted.

Saving the program

After you have defined all the seam paths, you can save the new seam 
program and specify a name.

11. Tap the Save... button.

 The window for entering the program name opens.

12. Enter the desired name. 

13. Confirm with OK ( p. 48).

 The program is now available under this name for sewing, editing or 
copying.

Important

After creating or changing a program, perform a contour test ( p. 60). 
Ensure that the contour lies within the limits of your particular unit.

5.11 Setting Mode X in Load and Deposit mode

In Load and Deposit mode, the machine has the Modes 1–5 ( p. 71). 

The starting position is always Mode 1. When a new seam program is 
created, Mode 5 is automatically set in Load and Deposit mode. After a 
successful contour test, Mode 1 must therefore be set in Load and Deposit 
mode. 

Information

If you perform a contour test, for example, it makes sense to set Mode 5 
in Load and Deposit mode. Mode 5 means:

• Load mode: Transfer plate is deactivated

• Deposit mode: Stacker is deactivated 

NOTICE

Property damage may occur!

Damage to the machine by exceeding the sewing field size.

If the sequence or seam programs do not match the configuration 
set, the movement of the clamps during sewing can cause damage 
to the machine or the sewing material.

Ensure that only sequences and seam programs which are suitable 
for the configuration set are used.
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The fact that the transfer plate and the stacker are deactivated facilitates 
and speeds up the contour test ( p. 60). 

To set the desired mode in Load/Deposit mode:

1. Tap the menu items Edit > Seam program > Sewing 
parameters.

 The Sewing parameters window appears. 

Abb. 48: Setting Mode X in Load and Deposit mode

2. Tap the PP2 Load mode/PP3 Deposit mode button. 

3. Tap the Mode X button. 
The Mode X button shows which mode is currently set. 

 The mode selection window appears. 

4. Tap the desired Mode X. 

5. Confirm with OK. 
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5.12 Performing a contour test

Information

It makes sense to set Mode 5 in Load and Deposit mode for the contour 
test. Mode 5 means the transfer plate is deactivated in Load mode and the 
stacker is deactivated in Deposit mode. This facilitates and speeds up the 
contour test. 

A contour test checks whether the entered contour lies within the limits of 
the sewing field, whether the shapes are correctly mounted and whether 
the selected seam program suits the configuration set used. 

After creating or changing a program, changing a seam contour or chang-
ing the shape, perform a contour test. 

To perform a contour test: 

1. Check whether Mode 5 is set in Load and Deposit mode.

When a contour test is performed for a new seam program, Mode 5 is 
automatically set in Load and Deposit mode. 

2. Set Mode 5 in Load and Deposit mode if necessary ( p. 58). 

3. Place material below the transfer plate. 

4. To lower the transfer plate, press the pedal.

5. Tap the menu items Edit > Seam program > Testing Contour. 

 The Testing Contour window opens.

Abb. 49: Performing a contour test

NOTICE

Property damage may occur!

Damage to the machine by exceeding the sewing field size.

If the sequence or seam programs do not match the configuration 
set, the movement of the clamps during sewing can cause damage 
to the machine or the sewing material.

Ensure that only sequences and seam programs which are suitable 
for the configuration set are used.
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6. Press both start buttons.

7. Move along the contour stitch by stitch using the Forwards and Back 
buttons.

8. Check that all points lie within the sewing field.

9. After a successful contour test, set Mode 1 in Load and Deposit mode 
( p. 58). 

5.13 Creating a sequence

You can combine up to 30 seam programs to form a sequence. You can 
create up to 20 sequences.

Selecting the seam program

To select a seam program: 

1. Tap the menu items File > New > Sequence.

 The window for selecting the seam programs appears.

Abb. 50: Creating a sequence

All existing seam programs are listed in the Seam programs field. 
The Sequence field shows the seam programs that are allocated to the 
sequence.

2. Tap the desired seam program.

 The selected program is highlighted with a dark background.

3. Tap the Insert button.

 The seam program is adopted the sequence and is displayed in the 
Sequence field at the left side of the screen.

4. Add further seam programs in the same manner.
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Removing a seam program from a sequence

1. Tap the seam program in the Sequence field and tap the Delete button.

 The program is removed from the sequence.

Assigning a name to the sequence

To assign a name to a sequence: 

1. Tap the Set name button.

 The window for entering the name opens.

2. Enter the desired name. 

3. Confirm with OK ( p. 48).

 The sequence is now available under this name for sewing, editing or 
copying.

5.14 Editing an existing sequence

You can edit an existing sequence by adding or removing seam programs.

Abb. 51: Editing an existing sequence

To edit an existing sequence: 

1. Tap the menu items File > Open in the main window ( p. 50).

 The sequence is opened in the main screen.

2. Tap the menu items Edit > Sequence.

 The window for editing the sequence appears.

3. Add programs to the sequence using the Insert button or remove from 
the sequence using the Delete button. The steps correspond to the 
procedure used for creating a new sequence ( p. 61).
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5.15 Saving a seam program/sequence under a different name

You can save a seam program or sequence under a different name.

Information

To create a new program, you can use a similar, already-existing program 
as a template. You can save the existing program under a new name and 
change the respective details.

To save seam programs/sequences under different names: 

1. Tap the menu items File > Save As.

 A selection window allowing you to select a seam program or 
sequence is displayed.

Information

You can limit the selection with File Filter. This makes the list more 
manageable ( p. 47).

2. Tap the desired element.

3. Tap the Save As button.

 The window for entering the new name is opened.

4. Enter the desired name. 

5.  Confirm with OK ( p. 48).

 The program or sequence is now also available under this name for 
sewing, editing or copying.

5.16 Copying a seam program or sequence

You can also copy seam programs or sequences from a USB key to the 
control or from the control to a USB key.

Information

Not all commonly available USB keys are suitable for the copying process. 
You can obtain a suitable USB key from Dürkopp Adler using the part 
number 9805 791113.
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Abb. 52: Copying a seam program or sequence (1)

To copy seam programs or sequences: 

1. Connect a USB key or other storage medium to the USB port (1). 

2. Tap the menu items File > Copy.

 The window for selecting the file to be copied appears.

Abb. 53: Copying a seam program or sequence (2)

3. Use the buttons (2) to select whether the data is to be copied from the 
DAC control or the USB key.

 The selected button is highlighted with a dark background. The files 
present at this location are listed in a selection window (3).

Information

You can limit the selection with File filter. This makes the list more 
manageable ( p. 47).

4. Tap the desired file.

 The selected file is highlighted with a dark background.

(1) - USB port

①

(2) - Select the source to be copied (3) - File selection window

②

③
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5. Tap the Copy File button.

 The selected file is copied to the USB key or the control.

5.17 Deleting a seam program or sequence

Seam programs or sequences that are no longer required can be deleted 
from the control.

Abb. 54: Deleting a seam program or sequence

To delete a seam program or sequence: 

1. Tap the menu items File > Delete.

 The window for selecting the file to be deleted appears.

Information

You can limit the selection with File Filter. This makes the list more 
manageable ( p. 47).

2. Tap the desired file.

 The selected file is highlighted with a dark background.

3. Tap the Delete button.

 The selected file is deleted.

5.18 Editing an existing seam program

You can change the contour and parameters of existing seam programs. 
The changes are applied to the seam program that is currently open on 
the main screen.
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To select the seam program to edit: 

1. Open the seam program you wish to modify via the menu items File > 
Open ( p. 50).

 The seam program is opened in the main screen.

5.19 Adjusting a contour

To adjust the contour: 

1. Tap the menu items Edit > Seam program > Contour adjustment.

 The contour adjustment window is displayed.

Abb. 55: Adjusting a contour (1)

2. Use the arrow buttons to move the cursor (1) to the position on the 
contour that is to be changed.

Information

You can also move to the position on the contour that is to be changed 
with the slider control (2).
Top scale: First stitch of the seam pattern.
Bottom scale: Last stitch of the seam pattern.

3. Tap the Go To button.

 The selected contour region is displayed in detail.

(1) - Cursor (2) - Scale: First to last stitch

①

②
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Abb. 56: Adjusting a contour (2)

4. Use the arrow buttons to select the stitching point (3) to be changed.

5. Tap the Go To button.

 The window for changing the seam path is displayed.

Abb. 57: Adjusting a contour (3)

6. Use the arrow buttons to move the stitching point to the new position (4).

 The modified seam path is displayed in green.

7. Tap the Next button.

 The window for selecting the technology operations opens.



(3) - Stitching point to be changed

③

(4) - Green: New stitching point (5) - Red: Old stitching point

④

⑤
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Abb. 58: Adjusting a contour (4)

Information

Define technology operations for the new seam path (optional):

• Tap the New button: Open the Technology operations window.

• OK button: Save and exit contour adjustment (continue with step 10).

Selecting technology operations

Abb. 59: Adjusting a contour (5)

NOTICE

Property damage may occur!

Damage to the machine by exceeding the sewing field size.

If the sequence or seam programs do not match the configuration 
set, the movement of the clamps during sewing can cause damage 
to the machine or the sewing material.

Ensure that only sequences and seam programs which are suitable 
for the configuration set are used.
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8. Select the desired technology operations for the new seam path 
( p. 46).

9. Confirm with OK.

 The previous window for seam adjustment is displayed.

10. Confirm with OK.

 A query appears to accept the changes. When you confirm, the mod-
ified contour will be saved.

Important

After creating or changing a program, perform a contour test ( p. 60). 
Ensure that the contour lies within the limits of your particular unit.

5.20 Changing parameters

You can also change the general settings that apply to the entire seam 
program.

Change parameters as follows: 

1. Tap the menu items Edit > Seam program > Parameters.

 The window for selecting the program parameter group is opened.

Abb. 60: Changing parameters

2. Tap the desired parameter group.

 The individual parameters of this group are displayed.

3. Tap the desired parameter.

 The window for modifying the parameter opens.

4. Set the parameter to the desired value ( p. 49).

There are 8 program parameter groups:

Symbol Parameter group

PP1 - Configuration
General settings
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Overview of the individual program parameters

PP2 - Load mode
Load mode and position

PP3 - Deposit mode
Deposit mode and position

PP4 - Soft start
Number of stitches and speed

PP5 - Needle thread monitor
Sensitivity value for the needle thread monitor

PP6 - Thread consumption
Values for determining thread consumption

PP7 - Move
Contour is offset in a particular direction

PP8 - Scaling:
The size of the contour is changed.

PP1 - Configuration

Symbol Meaning

Seam name
max. 20 characters

Minimum sewing foot stroke height
(min. = 1.0 .. max. = 10.0; Def. = 5.0 mm)
Sets this as the minimum value of the programmable sewing foot stroke 
height so that only this value needs to be adjusted when sewing thicker 
materials.

Adjusting the thread tension
(min. = 10 .. max. = 200; Def. = 100 %)
The thread tension profile for the entire contour is adjusted accordingly. 
A value of 100 % means that no adjustments are made.

Adjust empty-run speed
(min. = 10 .. max. = 200; Def. = 100 %)
The forwarding speeds are adjusted accordingly.

Clamp ID code
Barcode (ID code) of max. 10 characters for performing a safety check 
before the start of sewing (the barcode reader additional equipment must 
be activated)

Laser marking lamps
Up to four laser marking lamps for easier alignment of the sewing material 
can be controlled (the additional equipment must be activated)

Symbol Parameter group
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Needle back turn mode
The following options can be set:
Not activated: The needle remains at the Stop position.
After the entire contour: After completing all seams in the contour the 
needle is reversed to the value specified in the machine parameters.
After each seam (Def.): The needle is reversed after every seam.

Needle cooling
(On / Off)
Activates/deactivates the needle cooling.

Adjust sewing speed
(min. = 10 .. max. = 200; Def. = 100 %)
The sewing speed is adjusted by the specified percent value.

PP2 – Load mode

Symbol Meaning

Load mode
The following options can be set:
Mode 1 (Def.)
Standard sewing mode with transfer of the material.
In the insertion position, the outer frame, inner slider and transfer plate are 
open. The sewing procedure runs in the following order:
• Press the pedal: The transfer plate is closed.
• Press both start buttons: The material is transferred to the outer frame/

inner slider and the sewing starts.
Mode 2
Reserved (function as with Mode 1)
Mode 3
Reserved (function as with Mode 1)
Mode 4
Reserved (function as with Mode 1)
Mode 5
Mode for service purposes (e.g. for contour test).
The outer frame and inner slider can be put in three positions. The next 
position is set by using the pedal. The positions change in the following 
order:
• Outer frame closed and inner slider open
• Outer frame and inner slider closed
• Outer frame and inner slider open

Loading position
(On / Off)
With the loading position activated the clamps move to the desired position 
for convenient insertion of the sewing material.

Loading position X
The default value can be changed for corrections.
Loading position X and deposit position X must correspond.

Loading position Y
The default value can be changed for corrections.
Loading position X and deposit position Y must correspond.

Symbol Meaning
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PP3 - Deposit mode

Symbol Meaning

Deposit mode
The following options can be set:
Mode 1 (Def.)
Stacker active.
Mode 2
Reserved (function as with Mode 1)
Mode 3
Reserved (function as with Mode 1)
Mode 4
Reserved (function as with Mode 1)
Mode 5
Stacker inactive.

Deposit position
(On / Off)
With the removal position activated the clamps move to the desired 
position for convenient removal of the sewing material after the sewing 
procedure.

Deposit position X
The default value can be changed for corrections.
Deposit position X and loading position X must correspond.

Deposit position Y
The default value can be changed for corrections.
Deposit position Y and loading position Y must correspond.

PP4 - Soft start

Symbol Meaning

Soft-start stitch count
(min. = 0 .. max. = 10; Def. = 5)

Soft-start speed
(min. = 100 .. max. = 2000; Def. =300 rpm)

PP5 - Needle thread monitor

(min. = 0 .. max. = 99; Def. = 5)
Is only active if activated in the machine parameters.
(A higher value makes the needle monitor less sensitive.
99 = Needle thread monitor switched off in this program only.)
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PP6 - Thread consumption

Symbol Meaning

Thickness of material
(min. = 0 .. max. = 20.0; Def. = 0)
The thickness of the sewing material when pressed together.

Adjust thread usage
(min. = -10.0 .. max. 10.0; Def. 0)
Correction of the calculated values.

PP7 - Move

Symbol Meaning

X move 
(min. = -5.0… max. = 5.0; Def. = 0.0 mm)

Y move 
(min. = -5.0… max. = 5.0; Def. = 0.0 mm)

PP8 – Scaling.

Symbol Meaning

X scaling 
(min. = 80 .. max. = 120; Def. = 100 %)
100% corresponds to the original size.

Y scaling 
(min. = 80 .. max. = 120; Def. = 100 %)

X center point of scaling 
(min. = -150.0 .. max. = 150.0; Def. = 0.0 mm)

Y center point of scaling 
(min. = -150.0 .. max. = 150.0; Def. = 0.0 mm)
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5.21 Editing machine parameters

You use the machine parameters to define the basic machine settings that 
apply to all programs.

To edit the machine parameters: 

1. Tap the menu items Edit > Machine parameters.

 The window for selecting the machine parameter group is displayed.

Abb. 61: Editing machine parameters

2. Tap the desired parameter group.

 The individual parameters of this group are displayed.

3. Tap the desired parameter.

 The window for modifying the parameter value opens.

4. Set the parameter to the desired value ( p. 49).

There are 6 machine parameter groups:

Symbol Parameter group

MP1 - Configuration
General settings

MP2 - Limit values
Limit values for speeds and positions

MP3 - Needle thread monitor
Behavior after thread breakage

MP4 - Thread cutting
Speed, position and tension

MP5 - Clamping thread
Starting angle

MP6 - Counters
Settings for program and bobbin counters
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Overview of the individual machine parameters

MP1 - Configuration

Symbol Meaning

Needle cooling 
The following options can be set:
Without: No needle cooler activated. 
Air cooling (Def.): The needle is cooled with air while sewing the seam.
Ice cooling: Optional equipment.

Foot mode 
The foot can be operated in the following modes:
Jumping foot (standard mode): The foot only presses on the sewing 
material while the needle is in the sewing material. 
Presser foot: The foot presses continuously on the sewing material.

Sewing area size 
No function.

Optional equipment 
Reduced clamp pressure:
Optional equipment limiting the amount of clamp pressure to allow for 
better alignment on insertion. 
Stitch position optimization:
Optional equipment, activates stitch position optimization 
( Additional Instructions)
Laser marking lamps:
Optional equipment providing orientation lines on insertion for easier 
alignment. Up to 4 marking lamps can be switched on for each program. 
This setting only activates the option, the actual switching is defined in the 
program parameters ( p. 70). 
Barcode reader:
Optional equipment for performing a safety check before sewing. A barcode 
can be stored with each program. Agreement with the barcode on the 
clamp is checked. Sewing only proceeds when the barcodes agree. 
You enter the barcode ID in the program parameters ( p. 70).

Clamp type
No function.

Clamp limitation
Preset limitation (Def.)
No additional structures are taken into account. 
Special limitation
Individual limits are taken into account. 

Pedal
Raising and lowering the transfer plate.
Start buttons
By simultaneously pressing both start buttons, the sewing process is 
started.
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MP2 - Limit values

Symbol Meaning

Max. speed 
(min. = 500 .. max. = 3000; Def. =2700 rpm)
All sewing programs are limited to this maximum speed.

Max. run-empty speed 
(min. = 10 .. max. = 100; Def. = 100 %)
Limits all clamp movements of the outer frame/inner slider between the 
seams to this value.

Feed starting angle 
(min. = 30 .. max. = 350; Def. = 210 °)
The movement of the outer frame/inner slider during the stitch starts at this 
angle of needle motion.

Feed phase 
(min. = 30 .. max. = 100; Def. = 100 %)
This parameter defines how the outer frame/inner slider is to be moved 
during the stitch.
(A value of 100 % means that the desired outer frame/inner slider motion is 
distributed over the entire stitch.)

Needle back turn position 
(min. = 0 .. max. = 359; Def. = 0 °)
The needle is reversed at this angle in order to increase the clearance to 
the outer frame/inner slider.

 Edit times and routes
 This function is only for Dürkopp Adler Service personnel.

MP3 - Needle thread monitor

Symbol Meaning

Upper thread monitor mode
The following options are available:
Threading position: After detection of a thread breakage the thread is cut 
and the outer frame/inner slider then moves to the threading position. 
Cut thread (Def.): After detection of a thread breakage, the thread is cut 
and the outer frame/inner slider then moves to the contour position 
according to the defined reversing path.
Pausing: After detection of a thread breakage, seam motion is stopped.
Not activated: The needle thread monitor is ignored.

Reversing path after thread breakage 
(min. = 0 .. max. = 20; Def. = 5 stitches)
Number of stitches to be taken into account when reversing after a thread 
breakage.

Position of bobbin change X  
The value range varies depending on the subclass and sewing field size.

Position of bobbin change Y  
The value range varies depending on the subclass and sewing field size.
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MP4 - Thread cutting

Symbol Meaning

Cutting speed 
(min. = 70 .. max. = 500; Def. =180 rpm)
Speed of the cutting stitch.

Cutting position on 
(min. = 0 .. max. = 359; Def. = 180 °)
Angular position of the needle at which the thread cutting knife is switched 
on.

Cutting position off
(min. = 0 .. max. = 359; Def. = 359 °)
Angular position of the needle at which the thread cutting knife is switched 
off.

Thread tension during thread cutting 
(min. = 0 .. max. = 100; Def. = 10 %)
Thread tension of the cutting stitch.

Position for thread tension during thread cutting 
(min. = 0 .. max. = 400; Def. = 370 °)
Starting angle for the thread tension during the cutting stitch.
(At an angle greater than 359 ° the thread tension is activated in the next 
stitch.)

MP5 - Clamping thread

Symbol Meaning

Close thread clamp at 1st stitch 
(min. = 0 .. max. = 250; Def. = 180 °)
Start angle for closing the thread clamp during the first stitch.

Open thread clamp at 1st stitch 
(min. = 0 .. max. = 359; Def. = 340 °)
Starting angle for opening the thread clamp during the first stitch.
If the closing and opening angles are the same then the thread clamp is not 
activated.
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5.22 Checking and changing the technical settings

The technical settings are made via the menu item Extras > Service. 

Abb. 62: Checking and changing the technical settings

A password must always be entered in order to access the menu items in 
Extras > Service ( p. 44). 

MP6 - Counters

Symbol Meaning

Counter type 
The following options are available:
Increment counter (Def.)
The counter is incremented after each sewn program.
Decrement counter 
The counter is decremented after each sewn program.
Increment sequence counter 
The counter is incremented after each sewn sequence.
Decrement sequence counter 
The counter is decremented after each sewn sequence.

Reset value for the counters
(min. = 0 .. max. 9999; Def. = 0)
Value to which the counter is set when a counter reset is performed.

Set seam count for bobbin reserve
(min. = 0 .. max. = 100; Def. = 0)
A message is displayed to the user after the number of seams specified 
here have been sewn. A value of 0 deactivates the function.

Bobbin supply capacity
(min. = 0.0 .. max. = 400.0; Def. = 0.0 m)
A message is displayed to the user after the bobbin supply capacity has 
been consumed. A value of 0 deactivates the function.
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5.22.1 Adjusting the basic functions

Password options

Technical areas are protected from direct access and can only be reached 
through the master password. The master password is not intended for 
the operator, only for the supervisor, product manager or technician, for 
example ( p. 44). 

With the master password and operator password, two access levels are 
available.

• The master password provide unrestricted access. 
The password is 25483 and cannot be changed. 

• You can change the operator password and also define whether the 
password only applies to the technical menu items or must always be 
entered after the machine is switched on ( p. 79).

Changing the operator password

To change the operator password: 

1. Tap the menu items Extras > Service > Adjustments > Operator 
Password.

2. Tap the Change password button.

 The window for entering the new password appears.

Important

The password must not have more than 5 digits and must be different from 
the master password.

3. Enter the new password.

4. Confirm with OK.

Defining the operating password protected areas

To define the operator password protected areas: 

1. Tap the menu items Extras > Service > Adjustments.

 The Adjustments window opens.

2. Tap the Operator passwordoption in this window.

 In the next window the Activate / Deactivate option indicates 
the type of password protection:

•   - Comprehensive password protection activated: 
Password protection of the first action after switching on

•   - Comprehensive password protection deactivated:
Password protection for the technical menu items only 

3. Tap the Activate / Deactivate option to switch between the 
settings.

4. Confirm with OK.
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Important

Switch off and on again the machine to adopt the setting.

Changing the language

To change the language: 

1. In the menu item Extras > Service > Adjustments tap the 
Language option.

 The list of available languages is displayed.

2. Tap the desired language.

3. Confirm with OK.

 The screen is reloaded in the selected language.

Setting date and time

To set date and time: 

1. In the menu item Extras > Service > Adjustments tap the Date 
and time option.

 The data entry window for date and time is displayed.

2. Enter the date and/or time.

3. Confirm with OK.

 The entered values are adopted.

Setting the brightness

To set the brightness of the control panel: 

1. In the menu item Extras > Service > Adjustments tap the Touch-
Adjustments option.

2. In the following window tap the Contrast Brightness option.

 A window with slider controls is displayed.

3. Pull the corresponding slider control up or down to change the value.

 The changes are immediately displayed.

Testing the touchscreen

You can use the Extras > Service > Adjustments menu item to 
check that the touchscreen is functioning correctly over all areas of the 
screen.

To test the touchscreen: 

1. In the menu item Extras > Service > Adjustments tap the Touch-
Adjustments option.

2. In the following window tap the Touch Test option.

 An empty window is opened.
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3. Use your finger to tap various different points or draw lines.

 When the touchscreen is functioning correctly all touched points of 
the screen are marked.

5.22.2 Displaying system information

You can access the log settings and error lists via Extras > Service > 
System information.

To display the system information: 

1. Tap the menu items Extras > Service > System Information.

 The selection screen for system information is display.

Abb. 63: Displaying system information

2. Tap the desired symbol.

Symbol Meaning

Control unit events
List of the latest errors

Log configuration
Only for Dürkopp Adler Service personnel

Log visualizer
List of the last log settings
Only for Dürkopp Adler Service personnel

State of operation panel
Status appears in the log display
Only for Dürkopp Adler Service personnel
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5.22.3 Testing MultiTest machine functions

You can use the Extras > Service > Multi-test menu item to check 
the inputs and outputs, test the sewing motor, align the transport clamp, 
set the stroke position and calibrate the thread tension.

Abb. 64: Testing Multi-Test machine functions

Information

The  Transport clamp function is only intended for Dürkopp Adler 
service personnel, as it requires a special tool. 
Detailed information can be found in the  Service Instructions. 

Testing inputs and outputs

Important

The instructions only provide an overview of the test possibilities.

The tests may only be performed by qualified specialists that have re-
ceived training from Dürkopp Adler.

To test inputs and outputs: 

1. In the Extras > Service > Multi-test menu item, tap the switch-
ing outputs elements option.

 The IO Test Page window is displayed.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Do NOT reach into the machine during function 
testing of input and output elements.
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Abb. 65: Testing inputs and outputs

The input elements are listed and selected at the left side (1) and the 
output elements at the right side (2).

2. Use Select + or Select - to select the desired element in the respective 
area.

 The number of the element is displayed on the selected: button.

3. Tap the selected: button.

4. Test the element using the On/Off or Toggle buttons, depending on 
the type of the input or output element. 

(1) - Area for input elements (2) - Area for output elements

① ②

Input elements

No. Meaning

S1 Outer frame down

S2 Bottom inner slider

S3 Transfer plate up

S4 Left transfer plate

S5 Start (start buttons)

S6 Middle transfer plate

S7 Inner slider back (reverse)

S8 Outer frame up

S9 Needle thread monitor

S10 Bobbin cover

S11 Upper housing lock

S12 Residual thread monitor (hook thread)

S13 Transfer plate up/down (pedal)

S14 Reserve

S15 Oil level control sensor

S16 Pressure monitor

S17 Quick stop
Operating Instructions 906 - 02.0 - 11/2016 83



Programming
S100 Sewing motor reference

S101 X-axis reference

S102 Y-axis reference

S103 Z-axis reference

Output elements

No. Meaning

Y1 Foot mode

Y2 Opening the bobbin flap

Y3 Needle cooling on

Y4 Inner slider up

Y5 Inner slider down

Y6 Blow RTM

Y7 Stitch position optimization

Y8 Release inner slider

Y9 Threading mode display

Y10 Oil check display

Y11 Outer frame up

Y12 Outer frame down

Y13 Inner slider open/closed

Y14 Outer frame change of shape

Y15 Inner slider change of shape

Y16 Left/right transfer plate

Y17 Transfer plate change of shape

Y18 Change of shape up/down

Y19 Reset RTM

Y20 Throw over pants

Y21 Barcode reader

Y22 Eject pants

Y23 Bracket

Y24 Bundle removal

Y28 Reserved for laser

No. Meaning
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Testing the sewing motor

To test the sewing motor: 

1. In the menu item Extras > Service > Multi-test tap the Test 
sewing motor option.

 The sewing motor test screen is displayed:

Abb. 66: Testing the sewing motor

Important

Remove the thread from the needle and the thread lever before starting 
the test.

2. Tap the  button.

 The window for entering the speed opens.

3. Enter the desired value (300 - 2000 rpm).

4. Tap the  button.

 The window for entering the cutting speed opens.

5. Enter the desired value (70 - 500 rpm).

6. Tap the  button.

 The sewing motor runs at the entered speed.

7. Tap the  button.

 The sewing motor stops.

8. Tap the  button.

 The sewing motor runs at the entered speed.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Do NOT reach into the machine during function 
testing of input and output elements.
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9. Tap the  button. 

 The sewing motor stops, and the thread cutter is actuated.

Setting the stroke position

To set the stroke position: 

1. In the menu item Extras > Service > Multi-test tap the Set 
stroke position option.

 The following options are displayed:

2. Tap the desired symbol and execute the function.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

Do not reach into the machine when setting the 
stroke position.

Switch off the power to the drives when you wish to 
test the freedom of motion of the sewing foot rod.

Set stroke position

Symbol Meaning

Perform a reference run
Check the movement

Switch between jumping foot and presser foot
Switch over the mode of operation

Go to position
Set the sewing foot height

Switch off the power to the drives
Manually check the freedom of motion of the sewing foot rod
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Calibrate the thread tension

1. In the menu item Extras > Service > Multi-test tap the Thread 
tension option.

Abb. 67: Calibrate the thread tension

Information

The Thread tension calibration function is only intended for use 
by Dürkopp Adler Service personnel. Detailed information can be found in 
the  Service Instructions.

5.22.4 Initializing the control, performing updates

You can use Extras > Service > Initialization and update to 
reset the control and control panel to the factory defaults and to update the 
control with a new software version.

To initialize the control and perform an update: 

1. Tap the menu items Extras > Service > Initialization and 
update.

 The screen for initialization and update appears. 

Abb. 68:  Initializing the control and performing an update
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Initializing the control

Caution: Initializing the control resets all values to the factory default 
settings. All changes are lost.

Save your seam programs and sequences to a USB key before perform-
ing initialization.

1. Tap the Control Unit Initializer option.

 The control is reset to the factory default settings.

Initializing the control panel

Caution: Initializing the control panel resets all values to the factory 
default settings. All changes are lost.

1. Tap the Operation panel initialization option.

 The control panel is reset to the factory default settings.

Perform control unit update

Information

The latest software version is available in the download area 
at www.duerkopp-adler.com.

You can easily transfer a new software version from a USB key to the 
control.

Important

Not all commonly available USB keys are suitable for the copying process. 
You can obtain a suitable USB key from Dürkopp Adler using the order 
number 9805 791113.

To perform an update of the control: 

1. Switch off the machine.

2. Insert the USB key into the USB port (1) on the operating terminal.
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Abb. 69: Perform control unit update

3. Switch on the machine.

 The software update is performed automatically.

Information

If the automatic update does not function then you can use the menu items 
Extras > Service > Initialization and Update with the Control 
Unit Update option to import a specific software version manually.

Contact the Dürkopp Adler Service Hotline for this.

Displaying software version information

The menu item ? displays information on the software currently installed 
on the machine.

Abb. 70:  Displaying software version information

1. Tap menu items ? > Tap on Info (1).

 The following information is displayed:

• Class

• Subclass

• Version number, date of creation of this software version

(1) - USB port

①

(1) - Menu Info

①
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Creating programs with DA-CAD 5000
6 Creating programs with DA-CAD 5000

You can use the DA CAD-5000 program to create seam programs on a 
PC. The DA-CAD 5000 program is available as  additional equipment.

This chapter provides an overview of the program steps. 
A detailed description is provided in the  Operating Instructions for the 
DA-CAD 5000 program.

Selecting the class
The first step is to select the class.

Abb. 71: Selecting the class

Creating the seam contour

The next step is to draw the seam contour.

Abb. 72: Creating the seam contour
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Saving the seam contour

Abb. 73: Saving the seam contour

The final step is to save the finished seam program and copy it to a USB key.

Important

Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler using the part 
number 9805 791113.

To save a seam contour: 

1. Select the menu items Data transfer >  USB memory stick > 
Save (PC->>USB).

 After successfully saving to the USB key, the program can be 
transferred to the machine ( p. 93). 
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Transferring the sewing program to the machine

To transfer a sewing program to the machine: 

1. Insert the USB key and copy the desired file to the DAC ( p. 63).

2. Open the copied sewing program ( p. 50).

3. Adjust the program parameters (especially the sewing foot height, 
 p. 69).

4. Perform a contour test to check the clamp motion ( p. 60).

 Sewing with the program can begin after successful testing/adjustment.

NOTICE

Property damage may occur!

Damage to the machine by exceeding the sewing field size.

If the sequence or seam programs do not match the configuration 
set, the movement of the clamps during sewing can cause damage 
to the machine or the sewing material.

Ensure that only sequences and seam programs which are suitable 
for the configuration set are used.
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7 Maintenance

This chapter describes maintenance work that needs to be carried out on 
a regular basis to extend the service life of the machine and achieve the 
desired seam quality.

Advanced maintenance work may only be carried out by qualified special-
ists ( Service Instructions).

Maintenance intervals

WARNING

Risk of injury from sharp parts!

Punctures and cutting possible.

Prior to any maintenance work, switch off the 
machine or set the machine to threading mode.

WARNING

Risk of injury from moving parts!

Crushing possible.

Prior to any maintenance work, switch off the 
machine or set the machine to threading mode.

Work to be carried out Operating hours

8 40 160 500

Machine head

Remove lint accumulations •

Checking the oil level •

Clean and lubricate inner slider •

Check the hook lubrication •

Check the toothed rack and gear pinion •

Check and clean toothed belt •

Clean rotation spline shaft •

Clean linear guides •

Lubricate linear guides •

Infeed device

Clean and lubricate linear guide •
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7.1 Cleaning

Stacker

Clean and lubricate linear guide •

Pneumatic system

Check the water level in the pressure controller •

Check the filter element in the maintenance unit •

Check the tightness of the pneumatic system •

Electrical system

Clean control ventilation grill •

Clean sewing motor ventilation grill •

WARNING

Risk of injury from flying particles!

Flying particles can enter the eyes, causing injury.

Wear safety goggles.
Hold the compressed air gun so that the particles 
do not fly close to people.
Make sure no particles fly into the oil pan.

NOTICE

Property damage from soiling!

Lint and thread remnants can impair the operation of the machine.

Clean the machine as described.

NOTICE

Property damage from solvent-based cleaners!

Solvent-based cleaners will damage paintwork.

Use only solvent-free substances for cleaning.

Work to be carried out Operating hours

8 40 160 500
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Lint and thread remnants must be removed at least every 8 operating 
hours using a compressed air gun or a brush. When sewing very fluffy 
material, the machine should be cleaned more frequently.

Abb. 74: Cleaning

Areas requiring special cleaning

• Area around the needle (1)

• Area around the hook (2)

• Ventilation sieve on the control box (not illustrated)

7.2 Lubricating

(1) - Area around the needle (2) - Area around the hook

CAUTION

Risk of injury from contact with oil!

Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil.
If oil has come into contact with your skin, wash the 
affected areas thoroughly.

NOTICE

Property damage from incorrect oil!

Incorrect oil types can result in damage to the machine.

Only use oil that complies with the data in the instructions.

① ②
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Abb. 75: Lubricating

The machine is equipped with a central oil-wick lubrication system. 
The bearings are supplied from the oil reservoir.

For topping off the oil reservoir, use only lubricating oil DA 10 or oil of 
equivalent quality with the following specifications:

• Viscosity at 40 °C: 10 mm²/s

• Flash point: 150 °C

You can order the lubricating oil from our sales offices using the following 
part numbers:

Warning messages for oil level that is too low

• The lamp in the oil reservoir (1) lights up red.

• A warning message is displayed on the screen.

CAUTION

Risk of environmental damage from oil!

Oil is a pollutant and must not enter the sewage 
system or the soil.

Carefully collect up used oil.
Dispose of used oil and oily machine parts in 
accordance with national regulations.

(1) - Oil reservoir
(2) - Filler opening

(3) - Maximum level marking
(4) - Minimum level marking

Container Part no.

250 ml 9047 000011

1 l 9047 000012

2 l 9047 000013

5 l 9047 000014

① ②

③
④
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Proper setting

The oil level must always be between the minimum level marking (3) and 
the maximum level marking (4).

Checking the oil level

To check the oil level: 

1. Switch off the machine at the main switch.

2. Check the quantity of oil in the reservoir (1).

3. Pour in oil through the filler opening (2) as required.

4. Switch on the machine at the main switch.

Information

Always check the oil level after the machine has been stopped for an 
extended period of time. Refill with oil, if necessary. Allow the machine to 
run for approx. 10 cycles. Check the oil level again afterwards.

7.3 Servicing the pneumatic system

7.3.1 Setting the operating pressure

Proper setting

Refer to the Technical data ( p. 131) chapter for the permissible 
operating pressure. The operating pressure cannot deviate by more than 
± 0.5 bar.

Check the operating pressure on a daily basis.

NOTICE

Property damage from incorrect setting!

Incorrect operating pressure can result in damage to the machine.

Ensure that the machine is only used when the operating pressure 
is set correctly.
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Fig. 76: Setting the operating pressure

To set the operating pressure:

1. Pull the pressure controller (1) up.

2. Turn the pressure controller until the pressure gage (2) indicates the 
proper setting:

• Increase pressure = turn clockwise

• Reduce pressure = turn counterclockwise

3. Push the pressure controller (1) down.

7.3.2 Draining the water condensation

Water condensation accumulates in the water separator (2) of the pressure 
controller.

Proper setting

Water condensation must not rise up to the level of the filter element (1).

Check the water level in the water separator (2) on a daily basis.

(1) - Pressure controller (2) - Pressure gage

①

②

NOTICE

Property damage from excess water!

Excess water can cause damage to the machine.

Drain water as required.
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Fig. 77: Draining the water condensation

To drain water condensation:

1. Disconnect the machine from the compressed air supply. 

2. Place the collection tray under the drain screw (3).

3. Loosen the drain screw (3) completely.

4. Allow water to drain into the collection tray.

5. Tighten the drain screw (3).

6. Connect the machine to the compressed air supply.

7.3.3 Cleaning the filter element

(1) - Filter element
(2) - Water separator

(3) - Drain screw

①

② ③

NOTICE

Damage to the paintwork from solvent-based cleaners!

Solvent-based cleaners damage the filter. 

Use only solvent-free substances for washing out the filter tray.
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Fig. 78: Cleaning the filter element

To clean the filter element:

1. Disconnect the machine from the compressed air supply.

2. Drain the water condensation ( p. 100).

3. Loosen the water separator (2).

4. Loosen the filter element (1).

5. Blow out the filter element (1) using a compressed air gun.

6. Wash out the filter tray using benzine.

7. Tighten the filter element (1).

8. Tighten the water separator (2).

9. Tighten the drain screw (3).

10. Connect the machine to the compressed air supply.

7.4 Parts list

A parts list can be ordered from Dürkopp Adler. Or visit our website for 
further information at:

www.duerkopp-adler.com

(1) - Filter element
(2) - Water separator

(3) - Drain screw

①

② ③
102 Operating Instructions 906 - 02.0 - 11/2016



Setup
8 Setup

8.1 Checking the scope of delivery

Important

The scope of delivery depends on your specific order.

1. Check that all parts are present before setup.

Abb. 79: Checking the scope of delivery (1)

WARNING

The machine may be installed only by trained 
specialists. 

Wear protective gloves and safety shoes when 
unpacking and setting up.

(1) - Reel stand
(2) - CNC
(3) - Automatic stacker

(4) - Stand
(5) - Pedal

⑤

①

②

③
④
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Abb. 80: Checking the scope of delivery (2)

Scope of delivery:

• CNC-controlled double lockstitch machine (2), equipped with: 

• Automatic sewing foot and clamp lifting

• Stroke position adjustment

• Thread cutter

• Needle thread monitoring

• Threading device

• Multiple thread tensioning

• Automatic stacker (3)

• Compressed air maintenance unit (7) with compressed air pistol (6)

• Height-adjustable stand (4)

• Reel stand (1)

• Tools and small parts in accessory pack

• Additional equipment (optional)

8.2 Removing the transport locks

1. Remove all transport locks before setting up the machine: 

• Polystyrene

• Cardboard

• Tapes 

• Braces

Important

Keep transport locks for future transport.

(6) - Compressed air gun (7) - Compressed air maintenance unit

⑥

⑦
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8.3 Setting up the machine

When choosing where to set up the machine, make sure there is enough 
space to operate and service it.

8.3.1 Aligning the machine

Abb. 81: Aligning the machine

To align the machine: 

1. Insert the lifting carriage or forklift under the frame and relieve the stand 
feet (2).

2. Loosen the counternuts (1) on the stand feet (2).

3. Loosen the stand feet (2) so that the frame stands horizontally, evenly 
and stable on all 4 stand feet (2).

4. Tighten the counternuts (1) on all 4 stand feet (2).

5. Remove the lifting carriage or forklift.

WARNING

Risk of injury from moving parts!

Crushing possible.

Before start-up, make sure the machine has a 
secure footing.

Adjust the stand feet if necessary.

(1) - Counternut (2) - Stand foot

①
②
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8.3.2 Assembling the automatic stacker

Abb. 82: Assembling the automatic stacker

To fit the automatic stacker: 

1. Remove threaded screws (2) and cover plate (3).

2. Place support pipe (4) into the fork bracket and align the stacker so 
that the bars are a sufficient distance away from the tabletop.

3. Place cover plate (3) on top and screw tightly with six threaded screws (2) 
(screwdriver width 10 mm).

4. Tighten both threaded pins (1) so that the stacker is positioned in the 
fork bracket free of play (screwdriver width 5 mm).

5. Assemble the equipotential bonding (7):

6. Loosen hexagonal socket screw (screwdriver width 4 mm)

7. First place the washer, then the ring cable lug of the equipotential bond-
ing and finally the toothed lock washer onto the hexagonal socket screw 
and screw it tightly to the support pipe (4).

8. Attach the plugs of the valve control lines (6).

9. The allocation is clear from the labeling.

10. Connect the compressed air hose on the valve block to the pneumatic 
connection (5).

WARNING

Risk of injury from moving parts!

Crushing possible.

Carry out the installation with two people in order to 
avoid back injuries or crushing injuries if the 
machine falls down.

(1) - Threaded pins
(2) - Threaded screws
(3) - Cover plate
(4) - Support pipe

(5) - Pneumatic connection
(6) - Plug for valve control lines
(7) - Equipotential bonding

①

④

③

②

②

⑦

⑥

⑤
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8.3.3 Assembling the reel stand

Abb. 83: Assembling the reel stand

To assemble the reel stand: 

1. Insert the thread reel holder (1) into the drill hole (4) screw together 
with the nut (5)

2. Assemble the thread plate (3) and the thread guide (2) onto the reel 
stand in such a way that they are located precisely above one another.

8.3.4 Pedal setup

The pedal can be freely positioned in front of the machine as far as the 
cable allows.

Abb. 84: Pedal setup

To set the pedal: 

1. Position the pedal (1) so that the pedal and machine can be operated 
comfortably.

(1) - Reel stand
(2) - Thread guide
(3) - Reel plate

(4) - Hole
(5) - Nut

①

①
②
③

④
⑤

(1) - Pedal

①
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8.4 Electrical connection

Checking the mains voltage

1. Check the mains voltage before connecting the machine.

Establishing the electrical connection

1. Connect the mains plug: 230 V – 50/60 Hz. 

Sewing motor direction of rotation

It is not necessary to check the direction of rotation. The direction of rota-
tion is set automatically by the control.

DANGER

Risk of death from live components!

Unprotected contact with electricity can result in 
serious injuries or death.

Only qualified specialists may perform work on 
electrical equipment.

DANGER

Risk of death from electric shock!

The mains voltage must correspond to the voltage 
of the sewing drive that is specified on the rating 
plate.
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8.5 Pneumatic connection

The pneumatic system of the machine and of the additional equipment 
must be supplied with dry and oil-free compressed air. The supply pres-
sure must lie between 8 and 10 bar.

Proper setting

A minimum operating pressure of at least 6 bar must be maintained, even 
under maximum air consumption.

In the case of excessive pressure drop

What to do in the event of an excessive pressure drop: 

1. Increase the compressor power.

2. Increase the diameter of the compressed air supply line.

NOTICE

Property damage from oily compressed air!

Oil particles in the compressed air can cause malfunctions of the 
machine and soil the sewing material.

Ensure that no oil particles enter the compressed air supply.

NOTICE

Property damage from incorrect setting!

Incorrect system pressure can result in damage to the machine.

Ensure that the machine is only used when the system pressure is 
set correctly.
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Abb. 85: Pneumatic connection

Connecting the compressed air maintenance unit

1. Attach the connecting hose (3) (order number 0797 003031) to the 
compressed air supply using a ¼" hose coupling.

Setting the operating pressure

The operating pressure is 6 bar and is shown on the pressure indicator (2).

To set the operating pressure: 

1. Pull the adjustment knob (1) up.

2. Set the operating pressure in such a way that the pressure indicator (2) 
displays 6 bar:

• To increase the pressure:
Turn the adjustment knob (1) clockwise.

• To reduce the pressure:
Turn the adjustment knob (1) counterclockwise.

3. Push the adjustment knob (1) down.

(1) - Rotary handle
(2) - Pressure indicator

(3) - Connection hose

①

②

③
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8.6 Oil lubrication

For lubricating the machine, use only lubricating oil DA 10 or oil of equiv-
alent quality with the following specifications:

• Viscosity at 40 °C: 10 mm²/s

• Flash point: 150 °C

CAUTION

Risk of injury from contact with oil!

Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil.
If oil has come into contact with your skin, wash the 
affected areas thoroughly.

CAUTION

Risk of environmental damage from oil!

Oil is a pollutant and must not enter the sewage 
system or the soil.

Carefully collect up used oil.
Dispose of used oil and oily machine parts in 
accordance with national regulations.

NOTICE

Machine damage possible from incorrect oil level!

Too little or too much oil can cause damage to the machine. 

Ensure the oil level conforms to the information in the Operating 
Instructions ( p. 111). 

NOTICE

Machine damage possible due to incorrect oil!

Incorrect oil types can result in damage to the machine.

Only use oil that complies with the data in the instructions. 
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DA 10 can be obtained from DÜRKOPP ADLER AG sales offices using 
the following part number:

• 250 ml container: 9047 000011

• 1 liter container: 9047 000012

• 2 liter container: 9047 000013

• 5 liter container: 9047 000014

The sewing unit is equipped with a central oil-wick lubrication system. 
The bearings are supplied from the oil reservoir (1).

Abb. 86: Oil lubrication

Warning messages for oil level that is too low

• The lamp in the oil reservoir (1) lights up red.

• A warning message is displayed on the screen.

Proper setting

The oil level must always be between the minimum level mark (4) and the 
maximum level mark (3).

Checking the oil level

To check the oil level: 

1. Switch off the machine at the main switch.

2. Check the quantity of oil in the reservoir (1).

3. Pour in oil through the filling point (2) as required:

4. Switch on the machine at the main switch.

(1) - Oil reservoir
(2) - Refill opening

(3) - Maximum level marking
(4) - Minimum level marking

②①

③

④
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Information

Always check the oil level after the machine has been stopped for an 
extended period of time. Allow the machine to run for approx. 10 cycles. 
Check the oil level again afterwards. Refill with oil, if necessary. 

8.7 Performing a test run

When setup is complete, perform a test run to check the functionality of 
the machine. Adjust the machine to the sewing material requirements.

To do this, read the corresponding sections in the  Instructions for use. 
Read the corresponding chapters in the  Service Instructions in order to 
make adjustments to the machine if the sewing results do not conform to 
the requirements.

Performing a sewing test

To perform a sewing test: 

1. Switch off the machine at the main switch.

2. Thread needle thread ( p. 25).

3. Thread hook thread ( p. 28).

4. Switch on the machine at the main switch.

 The control is initialized.

5. Press both start buttons.

 The reference run starts.
The transport carriage moves to the reference position.

WARNING

Risk of injury from sharp and moving parts!

Puncture or crushing possible.

 Turn off the machine before changing the needle, 
threading the needle thread, inserting the hook 
thread bobbin, setting the hook thread tension or 
setting the needle thread regulator.

NOTICE

Property damage may occur!

Sewing without material may damage the machine.

Always place material under the transfer plate before starting the 
sewing process.
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Information

The reference run is necessary in order to obtain a defined starting posi-
tion of the transport carriage.

Pressing the pedal forwards triggers the different steps of the insertion 
procedure one after another and then starts the sewing process.

For selecting the seam program and other control settings see the section 
on Programming ( p. 39).

8.8 Transporting the machine

How to transport the machine to the set-up location:

1. Transport the machine to the set-up location in its original packaging 
using a stable lifting carriage. 

WARNING

Risk of injury from moving parts!

Crushing possible.

Incorrect transport can result in severe crushing 
injuries.

ALWAYS use a sturdy lifting carriage.

ALWAYS wear suitable protective clothing, in 
particular safety shoes and gloves.

Lift the machine a MAXIMUM of 20 mm.

ALWAYS securely fasten the machine.

NOTICE

Property damage may occur!

Risk of machine damage from unsecured transport.

NEVER transport the machine without the transport locks.
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9 Decommissioning

9.1 Decommissioning the machine

To decommission the machine:

1. Switch off the machine.

2. Unplug the power plug.

3. If applicable, disconnect the machine from the compressed air supply.

4. Remove residual oil from the oil pan using a cloth.

5. Cover the control panel to protect it from soiling.

6. Cover the control to protect it from soiling.

7. Cover the entire machine if possible to protect it from contamination 
and damage.

Information

Observe the necessary safety precautions for transport, ( p. 117). 

WARNING

Risk of injury from a lack of care!

Serious injuries may occur.

ONLY clean the machine when it is switched off.
Allow ONLY trained personnel to disconnect the 
machine.

CAUTION

Risk of injury from contact with oil!

Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil.
If oil has come into contact with your skin, wash the 
affected areas thoroughly.
Operating Instructions 906 - 02.0 - 11/2016 115



Decommissioning
9.2 Dismantling the automatic stacker

The dismantling of the automatic stacker is optional. It could be necessary 
to dismantle it for transport or space-saving storage.

Abb. 87: Dismantling the automatic stacker

1. Switch off the machine at the main switch.

2. Release quick coupling of the main compressed air supply.

3. Disconnect the compressed air hose on the valve block from the pneu-
matic connection (5).

4. Disconnect plugs of the valve control lines (6).

5. When disconnecting, simultaneously release the lock.

6. Remove the equipotential bonding (7):

• Loosen hexagonal socket screw (screwdriver width 4 mm)

• Remove the equipotential bonding line.

7. Loosen both setscrews (1) but do not remove them (screwdriver width 
5 mm).

8. Remove six threaded screws (2) (screwdriver width 10 mm) and cover 
plate (3).

9. Remove the automatic stacker from the bracket, rotate 180 ° (the 
protective bar is at the bottom) and carefully put aside.

(1) - Threaded pins
(2) - Threaded screws
(3) - Cover plate
(4) - Support pipe

(5) - Pneumatic supply
(6) - Plug for valve control lines
(7) - Equipotential bonding

Risk of injury!

The automatic stacker is heavy and has bulky 
dimensions.

Carry out the dismantling with two people in order 
to avoid back injuries or crushing injuries if the 
machine falls down.

WARNING

①

②

④

③
⑤

⑥

⑦

②

116 Operating Instructions 906 - 02.0 - 11/2016



Packaging, transportation
10 Packaging, transportation

The aspects relating to packing and transportation are described below. 
Keep to the procedure described here to ensure fault-free operation of the 
machine.

10.1 Assembling the transport locks

Transport locks must be fitted in order to protect the machine from damage 
during transport. The original transport locks are most suitable for this. 

1. To do this, go in reverse order from removing the transport locks 
( p. 104). 

10.2 Rotating the stand feet upwards

To increase the distance to the floor using a sturdy lifting carriage or forklift 
for transporting the machine, you can rotate the stand feet into the frame.

Abb. 88: Rotating the stand feet upwards

1. Insert the lifting carriage or forklift under the frame and relieve the stand 
feet (2).

2. Release the counternuts (1) on all 4 stand feet (2).

3. Rotate the stand feet (2) fully into the frame.

4. Tighten the nuts (1) so that the stand feet (2) remain fixed.

NOTICE

Property damage may occur!

Risk of machine damage from unsecured transport.

NEVER transport the machine without the transport locks.

(1) - Counternut (2) - Stand foot

①

②
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10.3 Packing the machine

Pack the machine so that it cannot slip or fall over. Select a stable base 
and fasten the machine to this. Also provide protection from external 
damage to the machine.

WARNING

Risk of injury from moving parts, weight of the 
machine and packaging materials!

Crushing possible.

Contact with packaging materials without wearing 
appropriate protective clothing can result in serious 
injuries.

ALWAYS wear gloves and safety shoes when 
packing the machine.

ALWAYS watch out for sharp edges on clamps, 
paper and packing straps.
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10.4 Transporting the machine

To transport the machine as safely as possible:

1. Assembling the transport locks( p. 117) 

2. Rotate the stand feet fully upwards ( p. 117).   

3. Fasten the carriage with belts. 

4. Pack the machine ( p. 118). 

5. Transport the machine. 

WARNING

Risk of injury from moving parts!

Crushing possible.

Incorrect transport can result in severe crushing 
injuries.

ALWAYS use a sturdy lifting carriage.

ALWAYS wear suitable protective clothing, in 
particular safety shoes and gloves.

Lift the machine a MAXIMUM of 20 mm.

ALWAYS securely fasten the machine.

NOTICE

Property damage may occur!

Risk of machine damage from unsecured transport.

NEVER transport the machine without the transport locks.
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11 Disposal

The machine must not be disposed of in the normal household waste.

The machine must be disposed of in a suitable manner in accordance with 
all applicable national regulations.

When disposing of the machine, be aware that it consists of a range of 
different materials (steel, plastic, electronic components, etc.). Follow the 
national regulations when disposing these materials.

CAUTION

Risk of environmental damage from improper
disposal!

Improper disposal of the machine can result in 
serious environmental damage.

ALWAYS comply with the national regulations 
regarding disposal.
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Troubleshooting
12 Troubleshooting

12.1 Customer Service

Contact for repairs and issues with the machine:

Dürkopp Adler AG

Potsdamer Str. 190
33719 Bielefeld, Germany

Tel. +49 (0) 180 5 383 756
Fax +49 (0) 521 925 2594
Email: service@duerkopp-adler.com
Internet: www.duerkopp-adler.com

12.2 Messages of the software

Please contact customer service if an error occurs that is not described 
here. Do not attempt to correct the error yourself.

12.2.1 Information messages

Information 
code

Description Troubleshooting

8400 Control panel has no valid program 
for the DAC.

Load the current program into the 
control panel from a USB key.

8401
8402

Control panel has no valid program 
for the DAC.

Load the current program into the 
control panel from a USB key.

8403 Program in DAC is no longer 
current.

Load the current program into the DAC.

8404

8407

DAC update was faulty. • Attempt the update again
• Check cable connections
• Replace the DAC

8408 Waiting for a DAC reset. Wait until the restart has been 
performed 
(Duration: several seconds).

8411 DAC program check is active. Wait until the test has been performed 
(Duration: several seconds).

8414 DAC update succeeded.
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8801

8805
8806
8890
8891

Error in test pins/signal processing/
event processing/
Memory wrapper/
list functions
Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

System

9000 Reference run active

9002 Machine head not locked down Lock down machine head

9006 Quick stop switch is activated. Releasing the quick stop switch

9016 Wrong bar code ID Change the program

9100 The counter has not reached the 
default value.

Tap the OK button. The counter is 
reset.

Information 
code

Description Troubleshooting
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12.2.2 Error messages

Error code Description Troubleshooting

Sewing motor

1051 Sewing motor timeout
• Cable to sewing motor reference

switch defective
• Reference switch defective
• Machine head does not move 

freely or has excessive belt tension

• Replace the cable

• Replace the reference switch
• Check the freedom of movement and 

belt tension of the machine head

1052 Sewing motor excess current
• Sewing motor cable defective
• Sewing motor defective
• Control defective

• Replace the sewing motor cable
• Replace the sewing motor
• Replace the control

1053 Sewing motor mains voltage too high Check the mains voltage

1055 Sewing motor overload
• Sewing motor blocked/not moving 

freely
• Sewing motor defective
• Control defective

• Fix blockage/sluggishness

• Check the sewing motor
• Check the control

1056 Sewing motor overtemperature
• Sewing motor not moving freely
• Sewing motor defective
• Control defective

• Eliminate seizing
• Replace the sewing motor
• Replace the control

1058
1302
1342

1344 

Sewing motor speed
• Sewing motor defective
Sewing motor error
Control not receiving pulses from 
pulse encoder in motor
Sewing motor error
Internal error 

• Replace the sewing motor
• Check the cable from the pulse 

encoder in the motor to the control
• Switch off and on the machine again
• Software update

Stepper motors

2101 X-axis stepper motor referencing 
timeout
• Faulty reference switch setting
• Faulty cable to the reference 

switch
• Reference switch defective

• Align reference switch
• Replace the cable

• Check reference switch

2102 X-axis stepper motor current error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable

• Replace the stepper motor

2152 X-axis stepper motor excess current • Replace the stepper motor
• Replace the control

2153 X-axis stepper motor overvoltage
• Mains voltage too high • Check the mains voltage

2155 X-axis stepper motor overload
• Feed system not moving freely
• Obstacle to feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion
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2156 X-axis stepper motor 
overtemperature
• Stepper motor sluggish
• Stepper motor faulty
• Control defective

• Eliminate seizing
• Replace the stepper motor
• Replace the control

2201 Y-axis stepper motor referencing 
timeout
• Faulty reference switch setting
• Faulty cable to the reference 

switch
• Reference switch defective

• Align reference switch
• Replace the cable

• Replace the reference switch

2202 Y-axis stepper motor current error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable

• Replace the encoder

2252 Y-axis stepper motor excess current • Replace the stepper motor
• Replace the control

2253 Y-axis stepper motor overvoltage
• Mains voltage too high • Check the mains voltage

2255 Y-axis stepper motor overload
• Feed system not moving freely
• Obstacles to the feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion

2256 Y-axis stepper motor 
overtemperature
• Feed system not moving freely
• Stepper motor faulty
• Control defective

• Eliminate seizing
• Replace the stepper motor
• Replace the control

2301 Stroke position stepper motor 
referencing timeout
• Faulty reference switch setting
• Faulty cable to the reference 

switch
• Reference switch defective 

• Align reference switch
• Replace the cable

• Replace the reference switch

2302 Stroke position stepper motor current 
error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable

• Replace the encoder

2352 Stroke position stepper motor excess 
current

• Replace the stepper motor
• Replace the control

2353 Stroke position stepper motor 
overvoltage
• Mains voltage too high • Check the mains voltage

2355 Stroke position step motor overload
• Feed system not moving freely
• Obstacles to the feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion

Error code Description Troubleshooting
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2356 Stroke position stepper motor 
overtemperature
• Feed system not moving freely
• Stepper motor faulty
• Control defective

• Eliminate sluggishness
• Replace the stepper motor
• Replace the control

Machine control

3100 Machine control voltage 
• Temporary mains voltage 

interruption 
• Check the mains voltage

3102 Machine voltage in sewing motor 
intermediate circuit 
• Temporary mains voltage 

interruption 
• Check the mains voltage

3103 Machine voltage in stepper motor 
intermediate circuit 
• Temporary mains voltage 

interruption 
• Check the mains voltage

3107 Machine temperature 
• Ventilation openings closed
• Ventilation grille dirty

• Clean ventilation grille 
• Check ventilation openings

3109 Threading mode is switched on Switch off threading mode  p. 17

3121 Inadequate air pressure Turn up air pressure and stabilize

3123 Oil sensor active Top off the oil  p. 97

3210 Thread broken Re-thread the thread 

3215 Bobbin empty (remaining thread 
counter)

Insert full bobbin  p. 29

3220 Bobbin empty (remaining thread 
counter)

Insert full bobbin  p. 29

3500 Error in calculating the contour data • Reload the contour data
• Check the contour data  p. 60

3501 Target position of the XY clamps 
outside the motion limits 

Adjust the contour data

3502 Target position of the XY clamps 
within the "forbidden areas"

Adjust the contour data

3721
3722 

Internal error • Switch off and on the machine
• Software update
• Notify DA Service

4201 Internal CF card defective • Switch off and on the machine
• Retrofit/replace control

5301 Program cannot be sewn Copy program to DAC  p. 63

Error code Description Troubleshooting
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6551

6554
6651

6653
6751

6761

Error in machine head position/AD 
converter/process error

Internal error

• Switch off and on the machine
• Software update 

• Notify DA Service

6952 Stepper motor driver error
Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

Communication

7801 Control panel interface 
communication
• Cable disturbance
• Cable 

• Switch off and on the machine
• Software update
• Notify DA Service

8151
8156

8159

IDMA error
• Disturbance
• Control defective

• Switch off and on the machine
• Replace the control

 8152

8154

IDMA error
• Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

8252
8257
8258

8256
8254

ADSP Boot/Xilinx Boot/ Boot error
Disturbance

• Switch off and on the machine

8351 Test pins error • Switch off and on the machine
• Software update
• Notify DA Service

9601 Stop while sewing on the contour
Continue sewing?

• OK button = 
Continue the sewing process

• ESC button = 
Interrupt the sewing process

9700 Bobbin case retainer not closed Close the bobbin case retainer  p. 17

9701 Parallel clamps not lowered • Remove obstacles
• Align sensors

9900 Incorrect machine parameters Initialize the data

9901 Incorrect sequences Initialize the data

9902 Incorrect program parameters Initialize the data

Error code Description Troubleshooting
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12.2.3 Errors in sewing process

Error Possible causes Remedial action

Unthreading at seam 
beginning

Needle thread tension is too 
firm

Check needle thread tension 
 p. 27

Thread breaking Needle thread and hook 
thread have not been 
threaded correctly

Check threading path 
 p. 25 

Needle is bent or sharp-
edged

Replace the needle  p. 24

Needle is not inserted 
correctly into the needle bar

Insert the needle correctly into the 
needle bar  p. 24

The thread used is 
unsuitable

Use recommended thread 
 p. 131

Thread tensions are too tight 
for the thread used

Check thread tensions  p. 32

Thread-guiding parts, such 
as thread tube, thread guide 
or thread take-up disk, are 
sharp-edged

Check threading path

Throat plate, hook or spread 
have been damaged by the 
needle

Have parts reworked by qualified 
specialists

Missing stitches Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle is blunt or bent Replace the needle  p. 24

Needle is not inserted 
correctly into the needle bar

Insert the needle correctly into the 
needle bar  p. 24

The needle thickness used 
is unsuitable

Use recommended needle 
thickness  p. 131

The reel stand is installed 
incorrectly

Check the assembly of the reel 
stand  p. 107

Thread tensions are too tight Check thread tensions

Throat plate, hook or spread 
have been damaged by the 
needle

Have parts reworked by qualified 
specialists
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Loose stitches Thread tensions are not 
adjusted to the sewing 
material, the sewing material 
thickness or the thread used

Check thread tensions

Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle breakage Needle thickness is 
unsuitable for the sewing 
material or the thread

Use recommended needle 
thickness  p. 131

Error Possible causes Remedial action
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13 Technical data

Noise emission

Workplace-specific emission value as per DIN EN ISO 10821:

LpA = 78 dB (A), KpA = 1.31 dB (A) at

• Stitch length: 3.0 mm

• Speed: 3000 rpm

• Sewing material: Double jeans

Data and characteristic values

Technical data Unit Class

Machine type Sewing unit

Type of stitches 301

Hook type Vertical hook

Number of needles 1

Needle system 134/35

Needle strength [Nm] 120 - 140

Thread strength for synthetics/core 
spun thread

[Nm] max. 90/3-15/3

Stitch length (programmable) [mm] Maximum 12.7 mm 
(Depends on seam pattern)

Speed maximum [min-1] 3000

Speed on delivery [min-1] 2700

Foot lifter [mm] 20

Sewing field size [mm] 210 x 210

Number of free seam contours 99

Mains voltage [V] 230

Mains frequency [Hz] 50/60

Power [W] 450

Operating pressure [bar] 6

Air consumption with needle cooling Dependent on the setting

Length [mm] 1900

Width [mm] 1520

Height
• Without height adjustment
• With height adjustment

[mm]
880-910
920-1270

Weight (fitted) [kg] 370
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Characteristics

Basic type

CNC-controlled, double lockstitch sewing unit based on class 867, with a 
DAC III control and specific software.

Application

Sewing pre-bound pockets, mainly back pockets up to a size of
210 x 210 mm, onto jeans.

Sewing material

Lightweight to medium-weight cotton and synthetic fiber materials.

Equipment:

• Automatic sewing foot lift

• Stroke position adjustment

• Short thread cutter

• Threading device

• Programmable needle thread tension

• Automatic material feeder

• Automatic stacker for stacking the material

• Overlapping mode of operation (while sewing or stacking, the next 
material can be inserted and the next cycle can be started)

Hook

Vertical hook (32 mm bobbin diameter)

Drive

• Drive via positioning drive:
In addition to the sewing drive, the DACIII control controls 2 stepper 
motors for the X and Y motion for creating the seam geometry and a 
Z axis for sewing foot adjustment.

• Pneumatic drive for the material feeder and the stacker.

• The arm shaft is driven by a brushless DC motor

• Maximum speed: 3000 min-1 intermittent (depending on the stitch 
length and material thickness)
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Programming

• Operated via the graphic control panel OP 7000

• 99 program storage locations, each with a maximum of 16000 stitches

• Programs can be sewn individually or in sequences

• Storage of up to 20 sequences, with up to 30 programs in each 
sequence

• Setting of individual stitch parameters per stitch for controlling stroke 
position of pressure foot, thread cutter, thread clamp, speed, thread 
tension etc.

• Integrated test program for servicing/maintenance work:

• Monitoring of the sewing process

• Setting of machine functions

• Creating of seam programs via a teach-In procedure.
The precision of the entry of coordinates for teaching is 0.1/1 mm

• Testing of motor functions, inputs and outputs for reference 
switches, valves and transport motors, RAM memory and EPROM 
functions

Sewing foot lift

Motorized sewing foot lift

Clamp slot

Pneumatic opening and closing of the clamps

Sewing field size

Maximum sewing field size: 210 × 210 mm

Lubricating

Central oil-wick lubrication system for machine head and hook

Number of stitches

Recommended number of stitches: 2700/min

Stitch length

Maximum stitch length: 12.7 mm
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Thread handling

• Electronic needle thread monitor

• Programmable needle thread tension:
Tension values for different thread extraction directions stored in seam 
program. This creates a neat seam pattern.

• Threading device:
Pulls the needle thread under the sewing material on the 1st stitch.

• Programmable stitch counter for hook thread monitoring and item 
counter

• Optional:

• Electronic remaining thread monitor

• Stitch position optimization kit: For seam optimization in the 
removal direction of 0 - 90°

• Barcode detection

Ergonomics

• Adjustable feet to even out the level of the floor and secure stance of 
the machine

• Working height of the front edge of the table top for operation of the 
machine while standing: 880 × 910 mm

• Table top tilted by 15° towards the operator

• Pedal freely movable within the available cable length
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14 Appendix

Fig. 89: Wiring diagram (1)
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Appendix
Fig. 90: Wiring diagram (2)
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Appendix
Fig. 91: Wiring diagram (3)
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Appendix
Fig. 92: Wiring diagram (4)
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Appendix
Fig. 93: Wiring diagram (5)
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Appendix
Fig. 94: Wiring diagram (6)
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Appendix
Fig. 95: Wiring diagram (7)
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Appendix
Fig. 96: Wiring diagram (8)
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Appendix
Fig. 97: Wiring diagram (9)
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Appendix
Fig. 98: Wiring diagram (10)
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Appendix
Fig. 99: Wiring diagram (11)
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Appendix
Fig. 100: Wiring diagram (12)
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Appendix
Fig. 101: Wiring diagram (13)
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Appendix
Fig. 102: Wiring diagram (14)
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Appendix
Fig. 103: Pneumatic diagram (1)
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Appendix
Fig. 104: Pneumatic diagram (2)
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